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Gurmukh Bhasin on designing 
a racing livery Page 26

 To begin the the livery I 
applied materials. KeyShot 6 
has an amazing library of 
materials which really helped 
speed up this process  

Supercharge 
your renders 

Page 22

David Hobbins
davidhobbins.com

Software Maya, KeyShot and 
Photoshop

Gurmukh Bhasin
gurmukhbhasin.com

Software Maya, KeyShot and 
Photoshop
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Welcome to 3D Artist! 
Farewell 2015 – it’s been fun. So 
much has happened in the last 
year, but here are a few things to 
jog your memory (and mine).

In January, Pixologic fi nally 
launched ZBrush 4R7. In April, 
Autodesk responded with Maya 
2016 and 3ds Max 2016, both of 

which were fantastic. Maxon released a new Cinema 
4D, two Houdini updates appeared and the Blender 
guys made a movie. We’ve seen several new 
contenders step up to the plate, with tools like Redshift, 
Corona and Substance becoming more and more 
prominent in the industry with each day that passes.

We’ve seen videogame devs achieve unbelievable 
levels of detail, with games like The Order: 1886 and 
Metal Gear Solid V pushing the boundaries of fi delity in 
videogame art. On the silver screen we’ve witnessed 
the return of Pixar with Inside Out and The Good 
Dinosaur, in the year that Toy Story celebrates its 20th 
birthday. We’ve experienced the cutting edge in 
computer graphics across fi lm and TV in 2015, and it 
can only get better.

We’ve been there to cover all of this and more, and I 
can’t wait to get stuck into the next 12 months. New 
tools, new techniques, VR, 3D printing – it’s all going to 
kick o�  in a big way. See you in 2016!

Steve Holmes, Editor
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To the magazine and 100 pages of amazing 3D
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Faster. Easier. More Realistic.
Cinema 4D Release 17 makes the easiest-to-use professional 3D software 

more e�cient than ever before. New tools as well as expanded and 

completely reworked features help you turn your ideas into reality even 

quicker and with less effort. The improved workflow helps you meet the 

tightest deadlines. We’ve even gone so far as to re-invent the line!

www.maxon.net

More variety than nature itself:

Cinema 4D Release 17
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This issue’s team of pro artists…

GURMUKH BHASIN
gurmukhbhasin.com

Head over to our rendering feature on 
p22 to fi nd out how Gurmukh added the 
fi nishing touches to our incredible Star 
Citizen cover image, with the help of 
modeller David Hobbins. 
3DArtist username Gurmukh

MARIANO TAZZIOLI
artstation.com/artist/mtazzioli96

Still super young, still super talented, 
Mariano dives into an interesting ZBrush 
workfl ow over on p58, showing you how 
to build a hard-surface robot based on 
more organic forms. 
3DArtist username n/a

VICTORIA GOLDSMITH
lowpolyfi sh.com

We’re always on the hunt for artists that 
do something a little di� erently. Victoria 
combines 3D techniques with Adobe 
Illustrator to develop an interesting, 
colourful papercraft style on p78.
3DArtist username lowpolyfi sh

ADAM SIMONAR
pamelagame.com

It’s been far, far too long since we’ve 
gotten stuck into a game engine, so 
Adam has come along to show you how 
to develop stunning science-fi ction 
environments in Unity. 
3DArtist username asimonar

RAINER DUDA
rainer-d.de

Christmas is just about over now, but to 
celebrate the holiday season Rainer has 
based his superb PBR materials tutorial 
on some good old fashioned Christmas 
baubles! You’ll fi nd it on p66. 
3DArtist username Rainerd

PAUL H PAULINO
paulhpaulino.com

MARI is a really useful tool, something 
that Paul explains over on p70 in his 
advanced texturing tutorial. Discover key 
look-dev techniques and production-
proven texture tricks.
3DArtist username paulhpaulino

NICOLAS DELILLE
modern-age-studio.com

Nicolas returns to the pages of 3D Artist 
with another Cinema 4D masterclass, 
this time focusing on one of the strangest 
bugs we’ve ever seen. It’s really weird and 
really awesome. Check it out on p50.
3DArtist username ModernAgeStudio

MATTHEW TREVELYAN JOHNS
artstation.com/artist/trevelyan

Hailing from a talented team at Cloud 
Imperium Games – the guys behind Star 
Citizen – Matthew shows you how to 
build a real-time prop that’s perfect for 
videogames on p74. 
3DArtist username trevelyan

ORESTIS BASTOUNIS
twitter.com/mrbastounis

For some reason we let Orestis have a 
month o�  last issue. He hasn’t gotten 
away with it again – on p82 he casts an 
expert eye over the Chillblast Fusion 
Render OC M4000 workstation. 
3DArtist username n/a

GURMUKH BHASIN
gurmukhbhasin.com

ADAM SIMONAR
pamelagame.com

This issue’s team of pro artists…

NICOLAS DELILLE
modern-age-studio.com

Nicolas returns to the pages of 3D Artist 
with another Cinema 4D masterclass, 
this time focusing on one of the strangest 
bugs we’ve ever seen. It’s really weird and 
really awesome. Check it out on p50.

VICTORIA GOLDSMITH PAUL H PAULINO
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Houdini 15 PBR Shaders

Advanced 
texturing in 
MARI

SAVE 40%
SUBSCRIBE TODAY

Turn to 
page 80 
for details

22

70

8

What’s in the magazine and where 

Matt Frodsham on using multipass to 
power up OctaneRender Page 29

 The multipass system is robust and 
really useful, even if it’s just for cleaning 
up areas in post-production  

 News, reviews 
& features
 10  The Gallery

A hand-picked collection of incredible 
artwork to inspire you

 22  Supercharge Your Renders
It makes such a huge di� erence – render 
times can make or break a 3D project, so 
feast your eyes on our vast collection of 
tips to get your renders moving at the 
speed you need

 32  60-Minute CG Fixes
Improve your character work, create 
awesome materials, touch up a short fi lm 
project and more in our expert guide to 
enhancing your scenes quickly

 64   Technique Focus: 1789 
Ekaterina Pushkarova-Katerin talks about 
how she dealt with post-processing when 
compiling her life-like scene 

 80  Subscribe Today!
Save money and never miss an issue by 
snapping up a subscription

 82  Review: Chillblast Fusion Render 
OC M4000
Orestis Bastounis delivers his verdict on  
this new workstation from the popular  
UK-based retailer

 84  Technique Focus: Salamander 
Crossbow
Martin Bosak explains his approach to 
modelling an amazing crossbow in Maya 
and ZBrush
 

What’s in the magazine and where 

78

66

Houdini 15 PBR Shaders

Advanced 
texturing in 
MARI

70

on using multipass to 
power up OctaneRender Page 29

really useful, even if it’s just for cleaning 
up areas in post-production

MARI

66

Papercraft 
in Maya

Houdini 15 PBR Shaders

SAVE 40%
SUBSCRIBE TODAY

and ZBrush

78

Papercraft 
in Maya
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The Pipeline
 42  Step by step: Build gorgeous 

sci-fi environments in Unity 5
Adam Simonar from NVYVE 
Studios teaches you a variety of 
videogame environment techniques

 50  Step by step: Achieve photoreal 
wildlife renders
Discover how Nicolas Delille creates 
such stunning nature images and 
re-create his Umbonia crassicornis

 58  Step by step: Mix hard surfaces 
and organic modelling
Mariano Tazzioli gets stuck into 
ZBrush and shows you how to 
generate unique cyborg concepts

 66  Pipeline techniques: Houdini 15 
PBR shaders
Learn from Rainer Duda what it 
takes to create believable materials 
and refl ections in your renders

 70  Pipeline techniques: Advanced 
texturing in MARI
Paul H Paulino teaches you to 
harness the texture painter’s power

 74  Pipeline techniques: Construct 
a real-time videogame asset
Level up your videogame props with 
this cool guide from Matthew Johns

 78  Pipeline techniques: Make a 
papercraft mask in Maya
Get to grips with this interesting 
technique from Victoria Goldsmith 

 The Hub
 88  Community news

Will Trojan Horse was a Unicorn live 
to see another event?

 90  Industry news
NUKE 10 details are out and 
Reallusion boosts Kinect's mocap

 92  Advertorial 
The VFX Festival 2016

 94  Readers’ gallery
Community art showcase

Achieve 
photoreal 
wildlife renders

Construct a real-time 
videogame asset

Build gorgeous sci-fi  
environments in Unity 5

Otávio Henrique Junqueira 
Amorim reveals how to make 

Blender even more e�  cient 
Page 36

•   Over three hours of 3ds Max 
and Unity video tuition from 
Pluralsight Creative (formerly 
Digital-Tutors)

• Humster 3D Corona models
•  Four CGAxis arch-vis models
• Loads of tutorial files
Turn to page 96 for the complete 
list of this issue’s free downloads

 The Blender owned sIBL GUI is an external 
add-on to help you with managing HDRI maps  

fi lesilo.co.uk/3dartist

DOWNLOAD FROM THEDOWNLOAD FROM THE

Visit the 3D Artist online shop at

for back issues, books and merchandise

74

32

42

50

9

Achieve 
photoreal 
wildlife renders
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Have an image you feel passionate about? Get your artwork featured in these pages
Create your gallery today at www.3dartistonline.com

 The idea was to represent how 
sentient robots of the future will still 
celebrate Eighties metal culture. I’m a 
huge rock/metal fan so I wanted to pay 
tribute to some bands I like. My idea came 
from the quote “the metal will live on” 
from a Tenacious D song 
Marco Plou�e, Rockerbot, 2015

Work in progress…

Marco Plouffe
marcoplou�e.com 
keosmasons.com

Software ZBrush, KeyShot, 
Photoshop

Marco studied character 
modelling in 2009 and it’s been 
his job and passion since then

10
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 I wanted to create a 
series of robotic organs. 

Among them is a futuristic 
heart – an eternal motor, 

that would be a lifesaver for 
humanity. Also, it was a test 

to see if I can work with a 
medical theme in 3D 

Vladislav Ociacia, 
Heart, 2015

Work in progress…

Vladislav Ociacia
bulldozer-vfx.com

Software 3ds Max, V-Ray, 
Photoshop

Vladislav is a concept modeller 
whose visual design fascination 
began in 2005

12
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 I wanted to challenge myself 
– with a female dancer, there’s 

a mix between strength and 
beauty. It’s important to have 

proper underlying anatomy and 
form, while retaining the 
softness of her figure 

Alex Lincoln,  
The Dancer, 2014

Alex is a freelance CG artist who 
looks forward to the next idea 
and creating visual narratives

Alex Lincoln
Alincoln3d.com

Software Maya, ZBrush, MARI

Work in progress…

13
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 On a cold January day in 2015 I 
aimed to create an image of a 
cosy bedroom with a warm and 
comforting sentiment. The focus 
of my work here was placed on 
the atmosphere; especially the 
mood in the lighting. My goal was 
to produce a photorealistic 
rendering of an interior scene 
Oskar Füleki, 
Bedroom, 2015

Work in progress…

Oskar Füleki
visumetrie.de

Software Cinema 4D, V-Ray, 
Photoshop

3DArtistOnline username: 
Visumetrie
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Alternate render…

Carsten Stüben
carstenstueben.com

Software ZBrush, 
OctaneRender

Carsten has been working as a 
creative director in a packaging 
design agency for nine years

 This image is part of a range 
of DynaMesh sketches, which I 

created in my spare time. If there 
is one theme which has been 

illustrated too often, it’s dragons. 
But I think it́ s not important what 

you create, but how. It́ s about 
reinterpreting the familiar and 

enhancing it with a personal 
touch. So here is my version 

Carsten Stüben, 
Dragon, 2015
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In depth

Taeho Son
taehoson.com

Software Maya, Mudbox, 
RealFlow, V-Ray, NUKE, 
Photoshop

Work in progress…

3DArtistOnline username: 
Neoptimist
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 This was my thesis project 
when I was at university. I have 
learned many things from this 
project. I wanted to establish a 

scene that can show detailed 
texturing with realistic modelling in 

a unique environment 
Taeho Son, UFM-258 Fairlady, 2014
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COMPOSITION
LEFT Personally, I always 
think that the composition 
and layout are some of the 
most vital things for a piece 
of art. I tried to make a 
natural flow for the eye with 
the shapes of objects and 
the layout. In this example, 
the horizontal items 
generate a flow, influencing 
the eyes to move from one 
point to another. The circle 
works as a captivating 
feature for the eyes to settle 
at. The vertical lines act as 
elements to force the eyes 
to come to a halt. 

FOREGROUND OBJECTS
ABOVE To create a depth of field effect, I placed several props in the foreground. I used 
VRayPhysicalCamera to adjust settings like focal length and field of view.

INSPIRATION
ABOVE The whole ship was inspired from my experience when I saw 
a cruise ship rolled over to the side from a massive storm. It was an 
amazing experience. I was also inspired by videogames like Call Of 
Duty and the Uncharted series.

 

 The scene takes place 
inside of a cabin interior 
of a wrecked ship. The 
ship is sunken and tilted 
to the side. From this 
project, I wanted to 
create an area where the 
whole place is abandoned 
but interesting 
Taeho Son, UFM-258 Fairlady, 2014
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1and1.co.uk*  1&1 Cloud Server 1 month free trial, then from £4.99 per month. No minimum contract period. Prices exclude 20% VAT. Visit 1and1.co.uk for full offer details, 
terms and  conditions. Intel and the Intel logo are trademarks of Intel Corporation in the U.S. and/or other countries. 
1&1 Internet Limited, Discovery House, 154 Southgate Street, Gloucester, GL1 2EX.

0333 336 5509

DOMAINS | MAIL | HOSTING | eSHOPS | SERVERS

TRIAL
TRY FOR 
30 DAYS1 CLICK

UPGRADE OR
DOWNGRADE1 CALL

SPEAK TO
AN EXPERT1

 Load balancing
 SSD storage
 Billing by the minute
 Intel® Xeon® Processor 

      E5-2660 v2 and E5-2683 v3

T O P  P E R F O R M E R

full page.indd   1 08/12/2015   11:19



22 23

SUPERCHARGE YOUR RENDERS
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SUPERCHARGE YOUR RENDERSSUPERCHARGE YOUR RENDERS

TOMGLIMPS
tomglimps.com

 3D generalist

JAMIE CARDOSO
jamiecardoso-mentalray.
blogspot.co.uk

 Computer artist/author

STEVE WILSON
stevesideas.net

 Freelance 3D artist

DAVID FLAMHOLC
fl amholc.com

  VFX supervisor/
motion designer

MARIO MALAGRINO
www.mariomalagrino.com 
fl orencedesignacademy.com

 Designer/teacher

SHAWN RABENSBURG
shawnrabensburg.com

 3D artist

ONDREJ POTANČOK
creativeamarena.com

  3D artist, specialising in
visualisation

DAVIDE DONI
behance.net/DavideDoni

  Environment TD
at Framestore

MATT FRODSHAM
mattfrodsham.com

 Motion designerExperts

22
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SUPERCHARGE
YOUR RENDERS

Achieving photorealism is “the greatest challenge for most 3D artists,” 
says freelancer Steve Wilson. Artist and author Jamie Cardoso 
agrees, adding “One of the biggest challenges today is to make 3D 

exterior shots look as realistic as the interior ones.”
For this challenge Cardoso has a set of rules, applicable whatever the 

renderer. He “uses amazing real photo references as the main source of 
inspiration for art direction, materials/shaders, lighting, colours, cameras 
and composition.” He also “ensures there is always a clear defi nition 
between bright and dark areas in the scene by visually emphasising where 

the main light source is originating from.” And where possible he “adds 
compelling skies in post. Amazing skies usually help ‘sell’ external shots.”

It’s a matter of balance; the following expert tips will help you learn the 
software, but don’t forget to feed your art too. As Wilson points out: “When 
you are a 3D artist you suddenly become aware of the smallest of details. 
The way the light hits an object: the dirt, scratches and layers of paint that 
have peeled o�  over time. Trying to achieve photorealism is a matter of being 
observant to the minutest of detail. I’m always looking at the world trying to 
work out how I could achieve that in 3D. It has become a habit.”

Rendering speeds can make or break a production. Our experts explain 
how to take control of your renders and achieve fantastic results 

23
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SUPERCHARGE YOUR RENDERSSUPERCHARGE YOUR RENDERS

Make the most of mental ray

 All in an instance
“Always use mental ray proxies in 
‘heavy’ scenes, and try to have most 
proxies as one instance if possible. 
Instanced proxies will use less 
memory to render.” 
JAMIE CARDOSO

 Alpha is luminance
“Usually, mental ray likes maps with alpha channels. Since in most cases we 
are using maps with white or no alpha channel, after you add in a map for 
specular or gloss remember to check Alpha Is Luminance in Color Balance.” 
DAVIDE DONI

 Highlight best features
“Glossy highlights play an important 
role in making an image more 
appealing. Increasing ‘Relative 
Intensity of Highlights’ can help 
accentuate glossy highlight e� ects.” 
JAMIE CARDOSO

 Use motion blur 
without deforming
“Test [motion blur] in No 
Deformation mode, which takes into 
account the whole object. When 
fi nished, turn on Full Deformation.” 
DAVIDE DONI

 Raise your rays
“Save the FG map at a smaller render output, followed by reusing the saved 
FG map to render the fi nal big output. While saving, set parameters high (eg 
Initial FG Point Density set to 0.8 and Rays Per FG Point set to 300).” 
JAMIE CARDOSO

 Get your lookdev right
“When you’re doing your lookdev, 
instead of plugging your specular 
map inside the Specular, connect it 
to the Specular Color and use the 
Specular value as a multiplier.” 
DAVIDE DONI

 The same raw material
“The material you want to use 
inside mental ray is almost always 
the mia_material_x_passes. With 
this you can achieve most glossy, 
matte or transparent materials.” 
DAVIDE DONI

 Light splitting with IBL 
“Set the image to Texture and colour 
to white. Tick Adjust Final Gather 
Color E� ects and Adjust Environment 
Color E� ects. Load a small HDRI, 
then the full res for refl ections.” 
DAVIDE DONI

 Correct glossy artifacts 
with glossy interpolation
“Use 1, or higher, in conjunction with 
relatively good Sampling Quality 
values. Also, enable ‘Highlights+FG 
only’, under the Refl ection group.” 
JAMIE CARDOSO

 Don’t make your 
luminance Unitless
“Glossy artifacts may be due to 
glowed objects set to Unitless. To 
fi x this, set as Physical units (cd/
m2) and increase the default value.” 
JAMIE CARDOSO

SUPERCHARGE YOUR RENDERS
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Add va-va-voom to V-Ray

 Render as you go
“Make simple versions of shaders 
and materials to avoid creating 
render bottlenecks. [This avoids] 
render problems in unbalanced 
lighting and GI fl icker.” 
DAVID FLAMHOLC

 Go the extra mile…
“VRayEdgeTex is a great procedural 
shader that creates fi llets on object 
edges without geometry fi llets. It 
can be the di� erence when trying to 
achieve photorealism.”
STEVE WILSON

 If you have to make a deadline…
“When the quality level is acceptable, use the V-Rray ambient light with a 
VRayExtratex texture inside to create a fake GI. Turning GI o�  elimates a lot 
of issues with fl ickering and can reduce render times substantially.“ 
STEVE WILSON

 Create product visuals 
with V-RayRT
“This lets me position lights, select 
an HDRI and set up composition. It 
supports the main V-Ray render 
engine to speed up production.” 
STEVE WILSON

 Keep it in the real world
“I model to scale in real-world units. 
It avoids problems with renders, 
gains render speed and looks better, 
as V-Ray lights are calibrated to 
work with real sizes and distances.” 
DAVID FLAMHOLC

 Use V-Ray meshes for 
high geometry scenes
“I often use V-Ray meshes when 
producing complex arch-vis scenes. 
Using it with MultiScatter or Forest 
Pro can quickly populate areas.“ 
STEVE WILSON

 Don’t starve V-Ray 
“Get your general DMC AA correct 
with the Sample Rate pass. Get the 
lowest value above 16 – even at a 
value up to 250. Then dial in your 
lights and refl ection subdivs.” 
DAVID FLAMHOLC

 Embrace dome lights
“When carrying out exterior 
animations I use a VRay Dome for 
refl ections by turning o�  di� use in 
the light options. I then create a 
VRaySun or Sky for main lighting.” 
STEVE WILSON

 Give V-Ray a hand
“Heavy scenes with hundreds of 
separate objects become heavy to 
handle, so I try to bake and combine 
as many meshes as possible to help 
V-Ray out.” 
DAVID FLAMHOLC

 Don’t sphere yourself in
“Don’t create a huge sphere around a simple scene for a sky or a backdrop. 
This creates an interior and slows the render. I’ve sped up renders from 20 
mins per frame to 1 min per frame by just replacing the enclosing sphere.” 
DAVID FLAMHOLC
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Rendering a racing livery for a Star Citizen spaceship

26

SUPERCHARGE YOUR RENDERS

01 Reworking an existing model This beautiful ship, 
the Mustang Omega, was originally designed by David 

Hobbins as the Mustang Alpha for the Star Citizen universe.  
My task was to take the Mustang Alpha (single-seat fi ghter) 
and do a quick redesign to turn it into a racer.  I was 
only allowed to change a few parts of the original 
design to give this ship a whole new racing feel, so 
the livery design played a large role in making this 
ship take on a new personality.

Get to grips with production-proven rendering techniques that 
will grease the wheels of your workfl ow

02 Choose the 
colours 

The colour scheme 
for the Mustang 
Omega was 
chosen as red and 
black because this 
ship was created as a partnership with AMD and 
Star Citizen.  Red and black are AMD’s fl agship 
colours. To begin the design of the livery I applied 
the basic materials. KeyShot 6 has an amazing 
library of prebuilt materials which really helped 
speed up this process. I applied steel, glass, 
rubber, warm emissive glow and a shiny 
metallic black paint to the ship. I used 
the grey studio HDR that comes 
with KeyShot for the 
environment lighting. I did 
four renders of the ship with 
di� erent colour materials 
applied (black, red, grey and 
yellow) that I will eventually 
composite in Photoshop.
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03 Layer in Photoshop 
In Photoshop I brought 

in all the di� erent colour ship 
renders and layer them on top 
of each other. I used the black 
ship render as the base colour 
for the ship and started 
masking in the red ship render 
with a soft Photoshop brush.  I 
like being able to easily control 
how much the red colour fades 
to black with a quick brush 
stroke, giving me lots of 
freedom to change the design 
of the livery as I see fi t.
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Imperium Games 
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Lucasfi lm and is currently 
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The original design of the 

Mustang was by Hobbins, with 
small changes like the wing 

shape and the livery scheme 
made by Bhasin
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04 Details for the ship I looked at 
references of Formula One racing cars to 

help fi gure out how the sponsor decals and racing 
logos should look when placed on the ship. The Star 
Citizen writers worked into the lore that AMD stands 
for Accelerated Mass Design and that they are a 
racing team in our Star Citizen universe.

05 Colour elements I 
used the yellow render 

pass to mask in a few arrows and 
triangles here and there, to help 
provide a little colour clash to the 
overall livery design.  Doing this 
will create some moments within 
the design that subtly catch the 
viewer’s eye, which will then 
cause them to explore the ship 
design further.

06 Filters and 
adjustments 

I made a few subtle layer 
adjustments with 
brightness and contrast, 
added a cool photo fi lter 
to the fi nal image and 
could fi nally call it a 
complete concept.
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Keep up with KeyShot

 Create your own 
softbox and photo studio
“Basically, this should simulate a 
photography studio for more control 
over refl ections of the environment 
on the objects that are in it.” 
MARIO MALAGRINO

 Bevel your edges
“By bevelling your edges and angles, 
you allow your light source to create 
more realistic highlights on the 
surface of your model where there 
are angles or where edges meet.” 
SHAWN RABENSBURG

 Remember to put in ground refl ections
“It is the details that will make your work stand out. So what I suggest to you 
is to add at least a bit of refl ection to the ground and blur it to 50 per cent. 
You will love the results, especially on darker backgrounds.” 
MARIO MALAGRINO

 Get enough gamma
“ Not crazy about how the light 
seems to be fading out your 
materials? Use gamma. This can be 
edited in post but you can also set it 
up in KeyShot and be done with it.” 
SHAWN RABENSBURG

 Set up (and save) 
multiple cameras
“My typical setup is to have a 
centred camera on each side and 
the top, then four or fi ve angled or 
close-up cameras.” 
SHAWN RABENSBURG

 Use materials with a 
little highlight
“This makes sure that even sharp 
corners are slightly highlighted. 
Materials that have no highlight give 
very fl at results.” 
MARIO MALAGRINO

 Use your ambient 
occlusion wisely
“However decent a render seems, 
you will pull out more details with 
an ambient occlusion pass to 
combine in Photoshop.” 
MARIO MALAGRINO

 Don’t aim for perfection
“If the goal is to make something 
look like you took a picture of it, 
keep in mind that most cameras will 
not produce a ‘perfect’ image.  
Emulate this.” 
SHAWN RABENSBURG

 Pick an HDRI that fi ts
“The best results come when the 
HDRI has a di� use light and hard 
light sources (eg a garage with neon 
lights and the refl ected light of a 
wall) for a good balance.” 
MARIO MALAGRINO

 Use depth passes rather than depth of fi eld
“By using a depth pass you can import your render into Photoshop and add 
the pass as an alpha channel, which will allow you to set the focus by 
altering the exposure and using lens blur to control your focal point.” 
SHAWN RABENSBURG

SUPERCHARGE YOUR RENDERS
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Achieve excellence with Corona Renderer

 Create materials with interactive confi dence
“When I’m creating materials and lighting, Interactive Rendering is always 
turned on. It supports features like fi nal frame rendering. It has no memory 
limitations, it’s fast and fi nally, it supports region rendering.” 
ONDREJ POTANČOK

 Get your tone map on
“One helpful feature is real-time 
tone mapping. You can adjust 
exposure, highlight compression, 
contrast and more. This helped 
speed up workfl ow and save time.” 
ONDREJ POTANČOK

 Go default for caustic 
and glass rendering
“Caustic and glass rendering is 
always time-consuming, but not in 
Corona! Glass material can let you 
ignore caustics if it’s unnecessary.” 
ONDREJ POTANČOK

 Selective rendering
“Advanced Render Select lets you 
tweak a single object in the scene 
without having to compute the rest. 
You can render objects with a black 
background for compositing.” 
ONDREJ POTANČOK

 Give products that 
believably perfect gloss
“On product renders and closeups 
in interiors, I like to move GI vs AA 
balance to 4 to 6 to speed up depth 
of fi eld or motion blur.” 
ONDREJ POTANČOK

Create seriously high Octane work
 Beware of not-so-useful passes

“Material IDs and Object IDs can be hard to control. Render Layer Mask can 
be assigned via a Layer ID with an Octane Object Tag.” 
MATT FRODSHAM

 Work smarter
“Leverage out of the core texture 
functionality to keep textures in 
system RAM instead of the GPUs 
vRAM. Rendering speed might drop 
slightly, but overall it will be possible 
to render seemingly impossible 
scenes even with cards that have 
very little video memory.” 
TOMGLIMPS

 When not ‘in-camera’ 
use multipass
“The multipass system is robust and 
really useful, even if it’s just for 
cleaning up areas in post-production 
on a per-layer basis. For example, 
noise often hides in refractions, 
which you can denoise without 
blurring your whole image.” 
MATT FRODSHAM
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MAKE YOUR RENDERS POP WITH PHOTOSHOP

01 Render ready Do your initial render, and 
then try using the Color Lookup 

adjustment in Photoshop, advises Shawn 
Rabensburg. “It’s deceptively simple,” he says, 
“but it can have a huge impact on how your fi nal 
image looks.”

02 Tweak your colours “Simply add Color 
Lookup as a new adjustment layer 

(Layer>New Adjustment Layer>Color Lookup) and 
scroll through the 3DLUT fi les until you fi nd a look 
that suits your image.  By adding this as an 
adjustment layer, you are still able to adjust the 
opacity, layer order and so on, so you will have full 
control over how the fi nal image winds up looking.”

03 Breathe life into your image “Color 
Lookup uses presets that alter the 

colours in your image to create a certain type of 
look. Your image may still need some 
adjustments afterwards to [make] it perfect, but 
often this tool does a great job of breathing a bit of 
life into fl at, dull images.”

MODEL BY Fateh Merrad (GrabCAD.com)

OUTSOURCE YOUR RENDERS

REBUSFARM
us.rebusfarm.net

Based in Germany, RebusFarm 
o� ers support for a wide array of 
3D applications and has built a 
strong reputation for o� ering 
stability and speed at a 
reasonable cost. RebusFarm also 
runs a popular Artist of the 
Month competition that you can 
fi nd on its blog.

Render farms are a great way to see results quickly, without the need for a monster workstation at home or in the studio. Here are fi ve to check out:

SUPERCHARGE YOUR RENDERS

 Prioritise your assets and time
“The Live Viewer is great for getting a feel for fi nal 
render settings. For most attributes you can start at 
0 then gradually increase values until you don’t 
notice a di� erence – any higher and you’re wasting 
render time.”
MATT FRODSHAM

 Optimise for repeat geometry
“Use proxies for repeated geometry to save valuable 
vRAM resources on your GPU, and keep scenes as 
light as possible. Generate CSV fi les using Phantom 
Scatter (written by Guus Thissen) for placing proxies 
exactly where you want them.” 
TOMGLIMPS

GPU VS CPU 
Getting right back to basics, rendering is the 
process of creating an image from your 3D 
scene and all of its data. Traditionally, rendering 
was always done via the CPU (central 
processing unit), but nowadays, a variety of 
studios are making the move to GPU rendering, 
looking to super-fast solutions like Redshift and 
Octane. It’s worth remembering, though, that 
these are two di� erent processes, and that 
there are quality considerations when thinking 
about rendering as well as any concerns you 
have about speed. When deadline comes 
knocking you’ll be after a fast solution, but don’t 
forget that quality is key. 

“I haven’t had a lot of experience with GPU 
rendering,” admits Steve Wilson, “but I can see 
the potential. Octane is one of the fi rst 
GPU-only renderers available. It lacks certain 
features that a CPU render engine [has] but I’m 
sure over time these features will be added. 

“It is always a dream of any 3D artist to see 
results instantly. With instant feedback you can 
tweak more quickly and achieve a higher quality 
level. Given time, I’m sure GPU rendering will 
become the rendering process of choice.”

GARAGEFARM.NET
garagefarm.net

GarageFarm claims to be the 
cheapest render farm around, 
and o� ers cool features like free 
test renders and multistep baking 
– these enable you to generate GI 
maps on multiple machines. You 
can try GarageFarm for free 
today without a subscription by 
going over to the website.

ZYNC
zyncrender.com

Used on over a dozen feature 
fi lms since its inception including 
Transformers: Dark Of The 
Moon, Zync is now part of 
Google’s Cloud Platform. At 
present Zync only supports 
Arnold for Maya, V-Ray for Maya 
and NUKE, but increased 
compatibility is on its way.

RENDERSTORM
render-storm.com

This is potentially where you 
want to head if you’re a Blender 
user, as RenderStorm o� ers GPU 
rendering for Cycles as well as 
CPU rendering for V-Ray for 
Blender and Blender Render. 
Other major software, such as 
3ds Max and Maya, is also 
supported at a CPU level.

RENDER ROCKET
renderrocket.com

This is another farm that o� ers 
test rendering to its customers, 
and it enables you to get a feel for 
the farm before committing to 
spending any money. As well as a 
powerful array of processor cores 
for you to utilise, Render Rocket 
also has a really handy 
web-based render manager.

022-030_3DA_Feat_Supercharge.indd   30 10/12/2015   10:58



Our revolutionary NEW 
Web Hosting platform

Call 0333 0142 708
or visit fasthosts.co.uk/hosting
SERVERS  •  WEB HOSTING  •  DOMAIN NAMES  •  EXCHANGE EMAIL  

Web Hosting from:

£1.99
per month ex VAT charged at 20%

230x297

guaranteed
UP TIME

100%

100% guaranteed 
uptime!

Smart SSD storage 
& intelligent load 

balancing

Dedicated SSL 
certifi cates

Full Page.indd   1 08/12/2015   11:19



32 33

60 MINUTE FIXES

032-040_3DA_Feat_60minute.indd   32 10/12/2015   11:29



32 33

Creating high-quality, detailed artwork in 3D is invariably a time-
consuming task so learning more productive workfl ows and quicker 
techniques to add an extra layer of polish to your work is a must. To 

help you surpass your goals, 3D Artist asked six professional artists for their 
time-saving techniques that can be achieved in under an hour.

There are always aspects of your 3D work that can be tweaked or 
improved on, and over the course of these mini tutorials you’ll discover 
battle-tested approaches, key techniques and also some software 
applications and resources you’ll want to adopt into your own pipelines.

Erwan Mayel takes us through his character creation process using his 
Musketeer character, employing a broad range of software applications. 
Erwan shares the design considerations he chose to shape the fi nal asset. 

Otávio Henrique Junqueira Amorim provides his steps for realistic 
rendering with Blender using the Cycles renderer. This will include creating 
realistic and detailed materials, using a truck in a blizzard as an example.

Using his Afrosamurai robot, Vladislav Ociacia explains how his rendering 
and compositing pipeline, which uses V-Ray, Photoshop and After E� ects, 
lets him tweak his fi nal output for a variety of results.

With his recent head bust project as a case study, Jonas Skoog kicks o�  
with how he created the initial sculpt and then shows us how to create 
tertiary details with hi-res displacement scans using ZBrush and MARI.

Last but not least, Laszlo Mandi and Robert Moore from Outpost VFX go 
through their workfl ow for creating seamless materials for a short fi lm.

Experts share their quick step-by-
step guides to help you upgrade your 

renders in under an hour

FIXES
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Iam going to show my character creation process 
using my Musketeer character, which I made as 
part of a personal project to help me improve my 

competencies. It was a challenge for me, mainly 
because I wanted to make an emotional character 
and implement all the techniques I have learned. 

Quick character creation and 
texturing with ZBrush

01 Research This doesn’t quite fi t into the 
60-minute workfl ow, but it’s essential for 

going into the process of creating your character. 
Doing an image search can help to block a plausible 
concept. There are several websites available to fi nd 
the necessary information. For my part, I used 
Pinterest. If you are drawing concept sketches to 
improve your idea on paper or on Photoshop before 
you begin sculpting, you can draw some silhouettes 
in black and white to improve your idea. Ultimately, 
the more research you have, the better equipped 
you will be with your project.

ERWAN MAYEL is a character artist at 
Square Enix, Montreal
erwanmayel.dunked.com

I’ll introduce you to a quick step by step for my 
workfl ow with ZBrush, 3ds Max, Marvelous 
Designer, Quixel/Photoshop, Hair Farm and 
V-Ray. I chose to make a musketeer that is based 
on The Three Musketeers. It is a book that I read 
when I was younger.
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02 Design phase Do a fi rst-pass blocking in 
ZBrush and make sure that everything 

begins with a sphere. The body does not have to be 
very detailed but should contain the necessary 
elements of the silhouette. For clothing, make a 
basic simulation with Marvelous Designer. For me it 
is the best clothing creation tool as it saves your 
production time and provides you with a more 
realistic result. It’s really di�  cult and time 
consuming to create a pattern from scratch. One 
technique you can use is to create a rough clothing 
sculpt in ZBrush and mask the di erent parts from 
your cloth, and then unfold these parts to give you 
an idea of how the pattern should look. For research 
on this, you can look at patterns in sewing books 
and observe your own clothing materials. All 
clothing is made with logic so it helps to think about 
how the garment was built. To create a good fold 
you may need to spend a bit more time; stay 
patient, it’s not easy and takes a few attempts to get 
a suitable result. Marvelous Designer generates a 
good simulation but if you want improve on the 
result further, return to ZBrush and rework 
problematic areas such as behind the knee and the 
armpit area, which are critical areas during 
simulation. Also, add details like stitches with 
custom brushes. I made my own but you can found 
a free brush set online with ease. 

03 Texture and lighting There are a bunch 
of texture and lighting resources you can 

utilise to help you save time. I use Quixel SUITE as 
it’s very useful when creating worn textiles and 
specifi c materials. If you want to create a worn 
texture, the best map to have for this is the 
Curvature map and you can generate this map by 
using xNormal. Another useful map is the Colour 
map; if you have everything on one mesh and you 
want to have many material e ects on this then you 
must separate with solid colours. Di erent areas 
will be grouped with the same material. For painting 
skin, use texture references from 3D.sk.com and 
project this using the Spotlight tool. Extrude skin 
details from the texture with ‘Mask by Colour 
Intensity’ and rework with the Skin brush. You can 
create the brush with a high-quality texture from the 
Surface Mimic website (surfacemimic.com). Now 
move quickly into testing the lighting of the scene 
and use 3ds Max with V-Ray because lighting is one 
of the most important aspects. Start with setting up 
dramatic lighting with shadows and rim lighting. The 
camera obscura technique was used by many 
Italian painters from the Renaissance to improve 
contrast. My full lighting setup uses an HDRI for 
ambient lighting and some directional lights to 
create some more contrast with the back light, rim 
light and soft light. Posing the Musketeer character 
is completed with the Transpose tool in ZBrush. It’s 
vital to have a good topology for animation 
deformation and the posing is very important for the 
presentation of a character. The emotion must be 
within the gestures. This gives more credibility to 
the realism of the character. For this character, I 
chose a contrapposto pose, an Italian term that 
means counterpose. I use a lot of historical Italian 
references for all of the processes at this stage. 
Overall, the best advice I can give is to observe and 
learn from Italian and French master sculptors. 

04 Hair system Hair is achieved with the 
Hair Farm plugin and rendered with 

VRayHairMtl. To make a more realistic hair system 
you must add some random messy hair into straight 
hair. With Hair Farm you have the opportunity to 
add modifi ers as you want, to improve detail and 
messy hair. Don’t forget to observe how hair and fur 
are in real life all around you. For the rest I use 
specifi c materials for each part because it helps me 
to create the best result. I used a seamless texture 
that I blended with the basic material texture to add 
detail into the refl ectivity.
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Create realistic materials with Blender and 
learn the importance of small details

02 Layers The fi rst layer represents the base 
material, the second is a fi ner rust layer, the 

third has rust edges and the fourth is for the snow. 
Simple materials generally only have the base layer 
and small details, in addition the most complex of 
these details may be mixed with other types of 
materials with di� erent physical properties. 
Exploring these details makes your rendering more 
realistic and visually more interesting.

1º Base

2º Rust texture

3º Rust edge

4º Snow material

Material Output

OTÁVIO HENRIQUE JUNQUEIRA AMORIM 
works in science communication with the creation 
of 3D animations in Brazil
otaviojamorim.blogspot.com.br

Arealistic render depends not only on 
correct modelling and elaborate lighting, 
but also on a number of choices that are 

dependent among themselves. Creating realistic 
materials works in this way, and in this tutorial I 
present the importance of creating an organised 
structure of materials and small details like rust 
and friction marks. As an example I will use a 
material that has been created for a personal 
project, a truck in a blizzard modelled with Blender 
using the Cycles renderer.

01 Study the material image First, a search 
for references is done of the physical 

functioning of the material in metal and snow 
situations. This is so we can study the way the 
material absorbs, refl ects or refracts the light and 
also the surface characteristics. It is possible to 
represent each characteristic material as a layer; for 
example in this project it was used in four layers.

03 Material and lighting Be sure to create 
the material with the lighting set up as 

close as possible to what you will have in the fi nal 
render, this avoids unpleasant suppression. Colour 
saturation issues in this case can be helped with the 
use of an HDRI map. The Blender owned sIBL GUI 
(Smart IBL) is an external add-on to help you with 
managing HDRI maps.

04 Stay organised The early creation of a 
material using the Blender Node Editor 

with the Cycles render engine should, from the start, 
always take into account the organisation of the 
nodes that are inserted. Working this way makes 
the operation clear and the editing facilitated.

05 Materials and masks The friction 
marks were made using a Normal map 

with a Bump node. The next step is the preparation 
of textures, rust and ice masks. The masks are used 
for di� erent types of materials and interact among 
themselves in rendering. There are two main ways 
of using masks in Blender: using Vertex Colors or 
external textures – this project utilised both. For the 
creation of rust on metal edges (for layer 4), I used 
Vertex Colors in Vertex Paint mode. To merge the 
snow material with the metal material, I used an ice 
texture in greyscale that was imported into Blender 
using the Texture Image node and had a Mix 
Shader’s Factor attribute applied. Organised nodes 
facilitate the use of the same material in other parts 
of the scene – for example, the snow material was 
used on other parts such as the wheels, tarpaulin, 
truck and ground.
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02 Texture mapping Now we will use the 
ExtraTex render element to apply dirt (with 

a big radius) using the Multiply option. Then we will 
use an ExtraTex with a small radius to highlight any 
details and again use Multiply. As before adjust the 
Opacity value for these.

VLADISLAV OCIACIA is a 3D concept designer 
and modeller from Ukraine
bulldozer-vfx.com

Here I will show you how to create stunning 
visuals in 3ds Max with the help of 
Photoshop and other quick tools – I will use 

my Afrosamurai robot as an example. The render 
took three hours to complete at 3000x3000px. I 
used V-Ray because it is has a great setup and all 
the functionality that we need. I used RGB, 
Refraction, Specular, Refl ection, VRayLightSelect, 
ExtraTex (two versions – one that is lighter and 
one that is hard light), SSS2, MultiMatteElement 
and ZDepth. Also, indirect illumination was used, 
but if you need to render quicker you can go 
without and later, in Photoshop, you can achieve 
the e� ect of indirect illumination with the help of 
passes you outputted (light select, total light and 
raw lighting). 

01 Render passes Assemble the passes 
using Photoshop. The RGB pass is the basis 

for this render. Next comes the Refraction pass with 
Blending mode set to Screen. Then duplicate the 
Refraction pass set to Colour Dodge. The Specular 
pass is set to Colour Dodge and fi nally a Refl ection 
pass is set to Screen. For all of these passes adjust 
the Opacity value, but the Refl ection pass in 
particular neds to be set to around 30 per cent.

03 Lighting The VRayLightSelect element 
can be used to tweak lighting in post. It’s a 

render element to extract the contribution of 
individual lights. We can use either Screen or Colour 
Dodge for LightSelect (depending on the work; for 
this we have used Screen and tweaked Opacity). 
Usually I use a minimum of three LightSelect passes 
for each light in the scene. If there are scene light 

04 Depth and compositing To create 
depth of fi eld we can use After E� ects 

with the help of the Lenscare plugin by Frischluft, 
which is very powerful. Also there are optical fl ares 
made by Video Copilot, (videocopilot.net) that 
could be a great addition for your artwork.

05 Post-production When you get to the 
stage of doing fi nal tweaks you can use a 

plugin for all kinds of di� erent colour corrections. I 
used Red Giant’s Magic Bullet Looks (redgiant.
com), and this can be used in both Photoshop and 
After E� ects.

elements then we can output a pass called 
Self-illumination and use it with Screen, and then 
blur it a little bit. With the help of a 
MultiMatteElement pass, which creates a selection 
of masks based on Multimatte ID or Object ID, cut 
the image from the background and work on the 
individual elements of the image to change its 
colour or texture.

Composite 
in 3ds Max
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Build tertiary details with hi-res displacement 
scans using ZBrush and MARI

02 Displacement scan These 
Displacement scans actually consist of 

three maps in one, spread across all three RGB 
channels. Combined, all you see is just a mix of all 
three channels in a brown-green tone, but separated 
you get very di�erent depths of detail. This gives me 
the ability to paint secondary details, tertiary details 
and microsurfaces simultaneously.

JONAS SKOOG is lead character artist at Bläck Studios, 
working mostly with cinematics and videogame trailers
jonasskoog.com

Creating fine details on your models can be a 
tricky process. Which way should the 
di�erent pores stretch and what types are 

there? Maybe you have a few alphas created from 
photo references or perhaps you paint them using 
various brushes in your favourite sculpting app? 
These techniques can indeed yield good results 
but it takes a lot of practice and understanding of 
the human skin to get there. What if you could just 

01 The model Sculpt the mesh in ZBrush to a 
decent level of detail by blocking in the 

major forms of the head. Use the Move and Clay 
Tubes brushes to get all parts like nose, mouth and 
eyes into place. Then move to secondary details 
such as big folds and crevices using Dam_Standard 
and Standard. Since this is a fictional character there 
are no concerns for any likeness. When happy with 
the result, ensure the model has proper topology 
and UVs. I usually project my sculpt onto a 
pre-existing basemesh which holds good UVs to 
save precious time and make room for the fun stu�. 
To do this, import the basemesh into ZBrush, align it 
to the sculpt with Move so they match in shape and 
subdivide it to roughly the same resolution as the 
sculpt. ProjectAll, found under SubTool>Project, is 
used to transfer the details over to the subdivided 
basemesh. This model is exported to MARI where I 
load up displacement scans in the Image Manager 
and paint them on like a Colour map using the Paint 
Through brush. Check your UV size before painting 
and choose a resolution that can hold all the details 
you are about to paint. The higher the resolution, the 
more details it can hold.

paint those details like you would an ordinary 
colour map – getting all the natural directions and 
types for free? 

In this tutorial I will cover how to quickly create 
tertiary details such as pores and fine wrinkles on 
a humanoid model using scanned displacement 
maps. The maps I used were created by a 
company called Texturingxyz (texturing.xyz) and 
will be released to the public very soon.
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03 Component menu Instead of painting 
unintuitive brown-green maps to see which 

channel is doing what, in MARI you can easily 
switch between them in the RGB component 
display and finish the work in your preferred channel 
view. When you are happy with the results it is time 

04 Final work in MARI There are a couple 
of di�erent ways to apply the details onto 

your model, but this is how I do it. I have two 
workflows that I alternate between depending on 
the e�ect that I want to achieve in the end. None is 
better than the other and they work best in 
combination with each other to give rich depth and 
detail to your skin. The first one is the simplest and 
is also the most straightforward. Load the map into 
the Displacement Map menu, set the parameters to 
your liking and click Apply. A low Intensity number 
here is preferred – probably around a value of 0.01 
to 0.03 so as to not overcrank the result. Make sure 
to enable the mode to see how the map displaces 
the mesh. The second workflow is a little trickier 
than the first. This time we will load the 
Displacement map into the Texture Map menu to 
set it as an albedo for your model. Now you can 
mask the details by going to Masking>Mask by 
Color>Mask by Intensity. If you now apply 
Deformation/Inflate, the unmasked details will be 
pushed out to create a similar e�ect to the previous 
workflow. Be careful with using Inflate since it can 
easily bloat your mesh. Both of these techniques will 
provide you with roughly the same result. Pick the 
one that you like the most or have a go at combining 
them like I did. As long as you are satisfied with the 
result, how you get there doesn’t matter. If 
everything has gone well you should now be on your 
way to a very realistic skin result.

05 ZBrush details Always work in layers to 
be able to step back if needed, and this is 

especially important if a client is giving you feedback 
or changing their mind about things. You can also 
play with the results with ease if you make use of 
Morph Targets along with the sculpting process. 
Just save a Morph before you apply any tricky 
details and shave o� the unwanted ones using the 
Morph brush.

06 Final work in ZBrush Now that you have the techniques pinned down you can experiment with 
the di�erent Displacement maps to create that extra depth of realism to your model’s skin. Use the 

Secondary Detail Disp for larger details like pimples and uneven skin and the other two for the fine pores 
and wrinkles down to the finest microstructure. Good luck!

to export the new Displacement map and separate 
the channels in Photoshop to give you the three 
di�erent maps you just painted. You could use the 
map as it is in ZBrush, but you will lose the control to 
fine-tune. When you have finished with everything, 
just import them into ZBrush.
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Make seamless blend materials 
for hard surfaces in Maya
LASZLO MANDI & ROBERT MOORE 
are 3D artists at OutpostVFX
outpostvfx.com

In this tutorial we’ll give you an overview of 
creating seamless blend materials in Maya. 
These are extremely powerful as you can reuse 

the same material for multiple objects but still end 
up with di� erences for each object based on its 
UVs. For example, we used this fairly simple 
grunge metal shader for all of the metalic parts of 
this engine instead of hand-texturing every piece. 
This was the workfl ow we used for the engine in 
our short fi lm ‘The Workshop’.

01 Analyse real objects When using this 
workfl ow the most important thing is to 

simplify. Analyse the real object and break it down 
into each type of material. In this case, a grunge 
metallic shader was broken down into three main 
materials: base metal, main grunge (all over the 
metal) and dust (in occluded areas). Another very 
important step is to gather your textures and make 
sure they are all seamless so you can tile them with 
the place2dTexture node in Maya. 

02 Check the UVs Before going on to the 
next step and creating the shader, you 

should check on the UVs of your model. Making 
sure that all of the UVs are uniform with hidden 
seams is always important when you are adding 
tileable textures, as UVs will create noticeable lines 
in your model. You can check the scale of your UV 
islands using a checker texture – making sure the 
checker is uniform will result in less texture 
resolution changes occurring.

03 Base material Now we create the base 
material, in this case it’s a simple 

aluminium/steel metal. As we will be layering extra 
materials on top, we need to create a base material 
with a very simple tileable gloss texture to break up 
the specular. The remap blue, red, green nodes are 
custom fresnel curves connected to the specular 
colour of the material to create a more realistic 
metal. You can fi nd out more about fresnels by 
Googling “custom fresnel curves in Maya”. 

04 Add noise to materials Next we will 
create the dust material. For this you can 

just use a simple material with no specular and a fl at 
brown colour in the di� use. In our case we wanted 
to add a very subtle variation to it so we started with 
a noise and pumped up the frequency for sand-like 
noise. We then pumped it into a layered texture and 
created a fl at brown colour value which was 
multiplied by the noise to create the variation. 

05 Grunge material For the fi nal material 
we introduce the main grunge/grime. We 

found a nice seamless grunge texture from which 
we created the di� use and the gloss. They were 
both tiled ten times in the place2dTexture node. At 
this stage it might become apparent that the texture 
is tiled on your model, however if your blend mask 
breaks up the material enough on your fi nal shader 
then this shouldn’t lead to any problems. 

06 Material blending For the fi nal stage, 
the main thing you need to worry about is 

how you are going to blend between the materials 
that you created. In this example, we want the dust 
material to show up in occluded areas, therefore we 
used an inverted AO mask to mask between the 
dust and the base metal. For the grunge, we used 
another modifi ed grunge seamless texture and tiled 
it about ten times.
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  BUILD GORGEOUS SCI-FI ENVIRONMENTS IN UNITY 5

42 

Expert advice from industry professionals, taking you from concept to completion
All tutorial files can be downloaded from: filesilo.co.uk/3dartist

 We will take advantage of 
Unity 5’s fully PBR HDR pipeline, 

achieving gorgeous and 
predictable results  

42 
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Over the next 17 steps we’ll be going over the design, 
workfl ows and fi nal composition techniques that 
we’re using to bring PAMELA to life in Unity 5. Our 

design process is focused on crafting believable architectural 
spaces in which gameplay will unfold; we utilise both 
real-world references and concept art to keep the 
environment relatable while still attaining a unique style. We 
will take advantage of Unity 5’s fully PBR HDR pipeline, 
achieving gorgeous and predictable results from texture 

Build gorgeous 
sci-fi environments 
in Unity 5
PAMELA is a sci-fi  horror game set in a fallen utopian city. Find out here 
how to re-create scenes from this exciting new release

authoring all the way to material creation in the engine. We 
will also walk through the process of setting up dynamic GI 
and refl ections in your scenes – these tools are crucial for 
maintaining a cohesive look in your environments. 

Lastly, we’ll go over some tips on utilising Unity’s 
post-processing tool, Image E� ects, and how to add extra 
depth and artistry to your fi nal image. Keep in mind that each 
of these topics could span a tutorial or two in and of 
themselves – there’s always more to learn!
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03

01 Start with the 
large scale Eden, 

the city in which PAMELA 
takes place, presented an 
immediately steep design 
challenge. When starting any 
design process, it is always 
best to go from the general to 
the specifi c. In this case, we 
began designing the overall 
architecture of the city, 
establishing the style at a very 
simple level. At this point, 
focusing entirely on shapes 
was more e� ective than 
worrying about texture detail 
and rendering quality. This 
way, we developed our 
language of clean lines, which 
can be embellished on later in 
the project.

02 Refi ne the look 
and mood Once 

we had developed enough of 
the large-scale architecture to 
be confi dent in the style, we 
produced mood paintings to 
showcase the design in the 
context. Even though the 
design itself is still highly 
subject to change at this 
point, these pieces can help 
us to set visual goals for the 
project as we continue to 
design and build.

03 Block out key gameplay spaces Once you’re 
satisfi ed with the large-scale architecture, move onto 

blockouts and secondary detail passes on small areas within 
the level. These can be paintovers, or rough 3D models – 
whatever helps you develop the space best. In doing this, you’ll 
be simultaneously testing your earlier work for fl ow, and further 
developing the scene’s visuals. After blocking out these key 
spaces, you can begin fi lling in areas between them to start 
tying the level together. Don’t be afraid to make signifi cant 
changes at this point; it’s much easier to make alterations now 
than it will be soon!

01

02

04

DOWNLOADS
from fi lesilo.co.uk/3dartist
• Tutorial screenshots

FREE
YOUR

ADAM 
SIMONAR
PAMELA – coming 
soon to PC, 2015

Software
Unity 5, 3ds Max, Photoshop, 
Substance Designer 
(optional), Substance Painter 
(optional)

Learn how to
•  Design sci-fi  environments
•  Create PBR content for Unity
•  Set up dynamic lighting and 

global illumination
•  Integrate HDR refl ections 

into your scene
•  Apply post-processing image 

eff ects to your camera
•  Use assets from the Unity 

Asset Store to enhance your 
workfl ow

Concept
PAMELA takes place in a fallen 
utopian city. We fi rst created 
an environment that refl ected 
the clean, peaceful aesthetic of 
such an area, then injected bits 
of disrepair to give players a 
sense of ‘wrongness’ as they 
explored the levels.

04 Build up geometry detail After blocking out the 
basic fl ow, you can continue to build up detail. At this 

point, we started working with basic tiling textures, without 
going too crazy with details and atlases yet. For our art style, 
much of the fi nal look comes down to the silhouettes and 
shapes, so we made sure to avoid over-texturing at this point.
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05

06

07
07 Import your meshes Unity 5 has a very 

straightforward import process for FBX files; simply 
create a Meshes folder (for organisation) and drag your files 
into it. If you have been modelling in real-world scale, your 
mesh will automatically be scaled correctly inside of Unity. It 
may also be helpful to toggle Generate Colliders on, so you can 
walk around in the space. Just remember that you should 
usually be creating separate collision meshes that have been 
optimised and cut down for this purpose.

Build up detail in stages
Be careful to avoid over-detailing on a small area in your 
level, early on in the process. It generally helps to have a 
rough idea of how far you will go with each detail pass on 
your level; for example, establishing rough geometry 
limits and texturing guidelines can make iteration much 
easier while you’re still early in the design process. It can 
also be helpful to do small case studies within your level, 
taking a chunk and bringing it up to a final quality level. 
This gives you a clear benchmark to aim for, just keep in 
mind not to jump to this stage too early.

05 Polish and export the scene After you’ve 
polished up the geometry and UVs in your scene, it’s 

time to export the meshes for use in Unity. Depending on the 
structure of your level, it is often best to export geometry in 
separate chunks rather than all together. Due to the nature of 
our environment, we’re not able to ‘modularise’ very much, but 
it is a good idea when possible. Export your chunks as FBX files; 
the default FBX settings will work fine in most circumstances. 

06 Generate PBR textures with Substance 
Substance Designer is a great way to improve your 

workflow when generating PBR content. Since any given 
material will require at least four or five texture maps (Base 
colour, Metallic, Roughness, Occlusion, Normal), Substance 
Designer makes it easy to co-ordinate your work across these 
outputs. You can achieve a great deal of depth in your materials 
by combining di�erent input maps and blending them across 
di�erent channels. Once you’re happy with your material, 
export the maps as TGA files.
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08

10

11

09

08 Import your textures As with models, importing textures into Unity is very 
straightforward; simply create a Textures folder in your project and drag them in. By 

default, all textures will be set to 2048px resolution, which can be increased up to 8192px if you 
require it. Most textures can have their Texture Type set to Texture, but for Normal maps this will 
have to be changed to Normal Map for the texture to function correctly.

09 Create your materials Once you’ve imported your meshes, you should see a 
Materials folder next to your FBX file in Unity. You can use these as starting points, or 

make your own folder for them elsewhere. To create a new material, right-click in your Project 
Panel and click Create>Material. In this example, we’re using an Alloy Physically Based Shader 
framework from the Unity Asset Store, which utilises a packed map containing Metalness, AO, 
Spec and Roughness in a single map, among other great features. If you’re using the Unity 
Standard shader, these maps would be input separately into the material.

10 Experiment with material types It’s helpful to line 
up your various materials as you’re setting them up in 

Unity. This gives you a good idea of how well they work 
together in the scene, and serves as a good lighting calibration 
tool. Since we’re working with PBR, it’s important to note the 
di�erences in that ways that metals, non-metals, and hybrid 
materials receive light. For example, sand is extremely di�use, 
whereas chrome is almost mirror-like and receives negligible 
direct light; these are obvious observations, but it’s important 
to keep them in mind as we move on to the next steps.

11 Add Reflection Probes Reflection Probes are objects 
that you place into your scene, which create cubemapped 

reflections for objects near them. These are crucial in adding 
extra depth and dynamism to your scenes, and can be easily 
placed throughout your level as needed. You can create Probes 
by right-clicking in your Hierarchy panel, and clicking 
Create>Light>Reflection Probe. You will want to size the Probe 
to roughly match the size of the room or area that it is located 
in; this will increase reflection accuracy.

The Asset Store is your friend
Throughout this article, a few third-party assets that we 
use from the Unity Asset Store are mentioned. We highly 
recommend investing in a few popular visual 
enhancement assets, like Alloy Physically Based Shading, 
Amplify Color, Natural Bloom and Dirty Lens. These are 
only a few examples and they can give you more 
flexibility in achieving rich, high-end visuals. Aside from 
visual assets, other assets can help you get started in 
other areas of game development, go check it out!
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12 Configure the Probes Once you’ve created a Probe, it is important to 
set it up correctly. By default, Probes are set to Realtime and their Refresh 

Mode is On Awake, meaning they will render once you hit play but will not 
update if anything is changed in play mode. You will likely want to check Box 
Projection; this will help your reflections follow the camera’s angle more 
accurately, and enhance the believability of the reflection. You also have options 
for resolution; usually lower values work just fine and save memory.

Make use of 
Light Probes
Light Probes, like 
Reflection Probes, are 
objects that can be 
placed into your scene 
to sample your 
environment. They will 
help to approximate 
global illumination onto 
dynamic objects in 
your scene, and do 
wonders to ground 
these objects. Note 
that dynamic objects 
do not a�ect the GI, 
but can still receive this 
lighting. We created an 
in-house tool that 
helped us to place 
these more easily, but 
the amount and layout 
of the Probes that you 
need will depend on 
your individual scene.

13 Set up GI static objects Unity 5 features real-time GI powered by 
Enlighten. The system is very powerful, but you must mark which objects 

will be static in the GI calculations. This is done by selecting the object, then 
clicking the Static dropdown, and choosing Lightmap Static. Keep in mind that 
the more objects you set as static, the longer your lightmapping process will 
take and the higher your performance cost will be. 

14 Configure lighting parameters Once you have set your desired objects as Lightmap Static, you will be able to 
pre-compute dynamic GI in your scene. Check the Auto box at the bottom of the lighting window, and Unity will 

automatically begin calculating your scene’s GI. Once this process is complete, you’ll be able to move lights around, change their 
intensity, play with emissive materials and the bounced lighting in your scene will update in real time. You can achieve great 
day-night cycles this way, and your scene’s real-time lighting will be much softer and realistic overall, at a slight performance cost.

14

12

13

47

042-048_3DA_89_SBS_Unity Enviroments.indd   47 09/12/2015   14:07



  BUILD GORGEOUS SCI-FI ENVIRONMENTS IN UNITY 5

48 

PAMELA – Bar Area, Unity, 3ds Max, Photoshop, 
Substance Designer (2015)  
A bar, found within a mall area in PAMELA.

PAMELA – Mall Walkway, Unity, 3ds Max, Photoshop, 
Substance Designer, (2015)  
One of the many walkways found in PAMELA’s shopping area 
that tie the stores together.

PAMELA – Clothing Store, Unity, 3ds Max, Photoshop, 
Substance Designer, (2015) A view from inside a clothing 
store, looking out towards the bright common space. 

Adam Simonar
Adam is the studio director and level designer at 
NVYVE Studios. With a background in architectural 
design, he is a self-taught CG artist and Unity 
developer. Along with the team, he’s currently 
working on PAMELA, a sci-fi survival horror game for 
PC. Here are a few images from the game.

All tutorial files can be downloaded from: filesilo.co.uk/3dartist

15

16

17

15 Add Image E�ects Image E�ects, 
Unity’s post-processing tool, has a 

profound impact on the mood and quality of 
your final image. They should ideally be added 
to your camera once you have completed your 
initial scene setup, as we’ve done here, so you 
aren’t relying on them as a crutch early on. 
Unity ships with a broad selection of e�ects; 
Bloom, SSAO, Vignette and Color Correction 
are some that we consider must-haves when 
aiming for a high-end, professional look. You’ll 
want to import the Standard Assets package 
from Unity, found on the Asset Store, which 
contains all of these e�ects and more to play 
with. Be careful, though, as adding too many 
post e�ects can hurt your frame rate.

16 Colour grading Correction and 
grading in terms of colour is an 

exceedingly important step in your e�ects 
chain, and is very inexpensive performance-
wise. With this tool, you’re able to colour 
correct your image in Photoshop, After E�ects 
or any other image editing tool, and replicate 
the results inside of Unity in real time. Just 
keep in mind that it is only able to replicate 
fullscreen, pixel-based colour corrections, not 
painted/unique e�ects. Unity ships with the 
Color Correction LUT Image E�ect which you 
can use to achieve this; alternatively, the 
Amplify Color plugin has a great workflow that 
makes the process even easier.

17 Final tweaks and testing As you’re 
finalising post-processing, explore your 

level to test the visuals in di�erent areas. If you 
spend all your time colour correcting a dark 
area and calibrating your values to that space, 
it is likely that these values will not work in 
average conditions. That being said, test your 
e�ects in extreme conditions that may arise in 
the game; sometimes unpredictable results 
can occur in fringe cases. The final look is 
always the result of iteration, and usually 
comes only after hundreds of minute tweaks. 
Don’t rush yourself!

The Unity community
One of the best parts about working 
with Unity is the amazing community 
surrounding it. If you’re ever stuck on 
a problem, chances are someone else 
has also dealt with it at some point, 
and often you’ll find answers on the 
Unity Forums or elsewhere. You’ll 
also find helpful tips and tutorials that 
can help you get more familiar with 
the various features Unity provides.
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  ACHIEVE PHOTOREAL WILDLIFE RENDERS

In this tutorial, we will see how we can manage to produce a 
photorealistic wildlife picture with Cinema 4D, ZBrush and 
Photoshop. We will go deep inside ZBrush to show you 

what you need to know to produce an insect full of details 
quickly and e�  ciently, with the help of essentials tools such 

as DynaMesh and ZRemesher. Then we will see learn how to 
export your model, light it, and set up a scene with V-Ray and 
HDRIs. And fi nally, we will learn how to keep all the details 
after fi nishing with ZBrush, and to enhance them inside 
Cinema 4D and then later inside Photoshop. 

Achieve photoreal 
wildlife renders

01 Gather references Any project based on a real 
insect deserves some references as a starting point. 

You can use Google and some stocks photo websites like 
Corbis, Getty or Fotolia to get some good references. They 
have always good subjects with good lights, so that helps a lot. 
Try to fi nd anatomical drawings of the insect as well. And best 
of all, you will have the same insect in several views.

03 The power of DynaMesh Now that we have all 
the views needed, we can start to sculpt. With a low 

opacity inside Spotlight, we can start to build the overall shape 
of the typical helmet of the Umbonia with a low DynaMesh 
sphere using the Standard, Clay and Move brushes. For this we 
will use the Symmetrical tool by clicking X and playing around. 
Keep the DynaMesh density low for now.

02 Spotlight We have some references so we can now 
load them inside Spotlight. Click on the Texture menu, 

import your references, and then for each of them click the + 
button and your picture will load with Spotlight. You can then 
decrease the opacity and start to work by clicking Z. If you want 
to come back to Spotlight, click Z again. You can collate several 
of these images together inside only one image to avoid having 
too many images inside Spotlight.

Discover how to use ZBrush and Cinema 4D to create a 
stylised insect integrated into a forest scene

NICOLAS DELILLE
Umbonia Crassicornis, 
2015
Software
ZBrush, Cinema 4D, V-Ray, 
Photoshop

Learn how to
•  Create an insect from scratch 

in ZBrush 
•  Use the basic features of 

ZBrush (DynaMesh, 
ZRemesher, maps) 

•  Export your fi nal mesh from 
ZBrush to Cinema 4D 

•  Set up a V-Ray scene inside 
Cinema 4D 

•  Create realistic lighting with 
HDRI and area lights 

•  Integrate a 3D rendering 
inside a 2D picture with 
Photoshop

Concept
Our starting point is to make a 
tiny insect called Umbonia 
crassicornis. Its atypical shape 
and colour makes it a perfect 
subject for a wildlife tutorial

0201

03

DOWNLOADS
from fi lesilo.co.uk/3dartist
• Tutorial screenshots

FREE
YOUR

Low density is the key
Why a low DynaMesh? Because it’s a crucial point. With 
a low DynaMesh, you have the freedom to change the 
shape very easily. It will be way harder and will take 
longer to do any changes after several steps. My advice 
is that you should compare your sculpt with several 
pictures and change the parts that don’t seem okay right 
now. If you have any doubts, make some changes or wait 
one day and look at it again. For example, I changed the 
helmet several times during this tutorial.
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The composition
Many guides will tell you how to create a nice composition. I 
would highly recommend you always keep in mind that for 
wildlife, and insects in particular, that close-ups are a good 
idea and look natural. Try to make it as close to your subject 
as you can to show the level of detail you’ve created and 
perfectly highlight all of the work you’ve done so far.
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  ACHIEVE PHOTOREAL WILDLIFE RENDERS

04

04Cut your insect into parts The helmet is the key element of this insect. We can use 
the Move tool and stick to our photo references to achieve the same shape. Once we 

have done the helmet at low resolution, the rest will flow. We can now start to make the eyes 
with the other element: we can add two simple spheres for the eyes (add one, put it in the right 
position, duplicate it and mirror it for the left). We can add another sphere to create the abdomen 
and one leg, and this will help us to have an overall view before starting to go into details. We can 
use the Ghost mode to keep the shapes around us and work precisely.

05

05DynaMesh – essential Not only does DynaMesh 
help you to keep a good and flexible resolution, it also 

has some Insert brushes that are very handy. We can use them 
to make the legs easier. With the Insert Cylinder and/or the 
Insert Sphere, we can work on the overall shape quickly. Once 
we are happy, we can Ctrl/Cmd+click once (not twice or all the 
elements inserted will merge together) and split them (using 
Subtool>Split>Groups split). Every element inserted will have 
its own polygroup. Easy!

 We can use the Ghost mode 
to keep the shapes around us 

and to work precisely 

  ACHIEVE PHOTOREAL WILDLIFE RENDERS
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Realistic lighting
Once again, take a look at real-life lighting and how the 
natural light can a�ect a closed space. When creating 
soft lighting in an interior you need to first analyse your 
scene in order to predict how the light will be distributed 
and where you’ll need support lights to brighten up 
shadow areas.

06

08

07

06 From low resolution to high resolution We 
have started our DynaMesh meshes with a low 

resolution (around 64). Now it’s time to increase the density a 
little bit more, and start to make more complex forms – but 
nothing too extraordinary yet. We will use the ZRemesher to 
simplify our mesh. Stick to what it should look like.

08ZRemesher Now that all of the parts of the insect 
are done, we can use the ZRemesher. It will change 

the topology and reduce the amount of polygons. We can use 
the standard setup of ZRemesher for this. For the helmet, we 
would recommend that you draw some ZRemesher guidelines 
so that the polygons flow in the right direction. This will be the 
most visible part of our insect, so the topology has to be good.

07The wings To make the wings, we will need to draw the stroke of one wing and the 
inner parts in Cinema 4D with the help of references. We can merge splines together, 

which will be crucial to the success for the inner parts. To do so, we can merge them with the 
Spline Union feature of version R17 (or with the Pathfinder in Illustrator). We can then use the 
Sweep tool with a low circle radius to add volume to the inner parts and make them editable. 
The spline of the stroke of the wings will be inside a loft generator, and we can edit it too. We 
now have two objects. For each of these, select it, and all its children, and choose ‘Connects 
objects + Delete’. Export the file as an OBJ and import it into ZBrush for your insect.

09

09Retopology and UVs All of the 
meshes of the insect are properly 

retopologised. We will now use the UV Master 
and click Unwrap for each piece. If you really 
want better control over UVs, we suggest you 
send your mesh with GoZ inside Bodypaint to 
tweak your UV. You can then stretch your UV 
to have more surface for your maps.

 Draw some ZRemesher 
guidelines so that the polygons flow 

in the right direction 

10

10Details and Polypainting Now we 
can add the finest details to our mesh 

with higher subdivisions. A high subdivision is 
required for your displacement and 
Polypainting maps. We usually stay with the 
Standard brush and with the standard alphas. 
You can find additional skin textures on the 
internet that can help, though. We will use a 
low spray with di�erent alphas and test them. 
We will need noise and bump on the insect’s 
surface to make it realistic. For the colour, you 
can use either Spotlight or a brush with colour. 
For this example, we can draw with colours 
following some references. For the holes on 
the helmet we used a black dot texture that 
was loaded onto it and used Masking>Mask 
by color>Mask by intensity. The Deformation 
Size tool was then used to make holes easily.
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Get wings with Cinema 4D R17
The new Spline tool feature with version R17 is impressive. You can now draw very 
precise curves, retouch any splines easily and use a Pathfinder. For the wings, we can 
draw all the inner splines separately, select them all, and choose one of the available 
spline options. For this example, with just one click we were able to merge all the 
splines together. Very handy.

11

11 Finalise the insect While detailing the leg, add a tiny detail to it. The Umbonia has a 
red segment that was added. Whilst working with DynaMesh, you can easily rebuild the 

leg with the segment, then use ZRemesher and make the UV quickly. In Cinema 4D, generate 
the other legs with a mirror duplication. We put two little eyes in front of the head too. Pay 
attention to all of the details, as they will be worth it later when rendering. When we’re happy 
with the result, we can generate maps. We must stay at subdivision 1 and generate our 
displacement map with standard value, and we will create our textures from Polypainting.

Nicolas Delille
I’m an international 3D artist, currently working in Paris. 
My clients are based in France, England and Australia 
for the most part. I won some prizes and recognition for 
my digital works in the advertising and 3D industry. I 
also have a big crush on animals and nature in my 
personal works.

Ladybug Journey 
ZBrush, Cinema 4D, V-Ray, Photoshop (2013)
Awarded by 3D Artist magazine as the best image of the 
month – this is the picture I’m the most proud of. I made two 
images for this character.

Lipton – Visual 1 
ZBrush, Cinema 4D, V-Ray, Photoshop (2013)
I wanted to do this fake ad about Lipton tea. I wanted to show 
that everybody on earth and beyond could love that flavour. So 
I imagined many crazy aliens’ hands holding a cup of tea.

Glossy Nature 
ZBrush, Cinema 4D, V-Ray, Photoshop (2014)
Published as a Technique Focus in 3D Artist, I wanted to skip 
textures to focus on the shape of the animal and do a series of 
glossy colourful animals blended with their environment.

12

12From ZBrush to Cinema 4D We’ll leave ZBrush now and move into Cinema 4D. 
First of all, keep in mind that ZBrush with GoZ can create a very large-sized mesh. V-Ray 

is sensitive to the real-world size of your mesh, so check the size and reduce it if you have too. 
We divided the size by 10. You can check the Export menu in ZBrush and set all of the o�sets to 
0, and the scale to 1 to help, and then resend your mesh. Next, GoZ can help you to know the 
size of each displacement map in your material. Start by dividing each displacement number by 
10. Keep the number and multiply it by -0.5 to get the right number. Now your displacement is 
correct. It’s a good starting point for increasing or decreasing it.
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 With DynaMesh, you can 
easily rebuild the leg with the 

segment, then use ZRemesher 
and make the UV quickly 
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The art of lighting
You can have the best mesh ever, but if you mess with your lighting, you result will not be 
great. On sIBLou you can find some good, free HDRIs to start o� with (hdrlabs.com/sibl/
archive.html). Build your light layer by layer. Try to find the balance between natural light 
and studio light to have a realistic creature sublimated by your lighting. For this image, we 
will use one HDRI and three area lights.

15

16 17

15 Fur and final rendering To add some realism, let’s add some hair to our insect. We 
will need very low values (with a thickness of around 0.006). For each part, we will do a 

hair object, so we will be able to control how much hair we want anywhere. We can duplicate our 
insect, and remove all the materials and displacement to do quicker test renders. When you are 
happy with the result, you can now do the final rendering with a high AA and DMC Sampler. 
Don’t forget to assign alpha masks to your elements. You can assign a material ID for your hair 
material for Photoshop. Also, make sure you increase the subdivisions of your lights (at least 24). 
We won’t be using global illumination here, because we don’t need to.

16 Shadow and multipass We are at 
the end of the road – well, nearly! We 

have our raw file with our insect sitting on a 
green branch, as well as a file full of 
multipasses. With them, we can extract the 
insect from its background. With the material 
multipass we can extract the hairs, and with 
the branch we can extract some shadows. To 
do so, desaturate the layer of the 3D branch, 
and put the layer on Overlay mode. Tweak the 
levels. We can do shadows too by using a wet 
brush and black colour. We have a lot of 
multipass to play with to add some realism to 
our insect.

17 Final image We can play with the 
glow behind the Umbonia to integrate it 

better with the scene. With a wet white brush, 
we can paint on some subtle bokeh e�ects 
that will touch our insect with a low opacity. 
We can play with the colour correction too to 
add a fancy look and a blur to our final image. 
Try not to do too much to the render though, 
as some images can be ruined by the use of 
too many e�ects – they have to serve your 
image in the first place. Anyhow, you can 
duplicate layers, test di�erent kinds of fusion 
modes to your layers and that’s how you will 
find some of the more interesting e�ects. 
Hope you’ve enjoyed this tutorial!

14

13

14The lighting Move the insect until you find the right 
placement, then build your lighting. For this example, we 

will need a strong light above and some orange light below. We 
definitely have to keep that in mind for the lighting and this will 
be the role of two of the three area lights. One for the Sun with 
the HDRI (as the key light), one above and one just above the 
camera, in front of the Umbonia, to reduce the darkness of the 
key light. We will use the free HDRI Topanga Forest and put the 
Sun from this one behind the insect. Now do some test renders 
to determine which area lights can be increased or decreased 
in value, and if the HDRI has to have a value higher than 1. For 
this scene, we can put a value of 2.5 for the HDRI, 15 for the 
area light that strengthens the sun impact, 0.15 for the area 
light in front, and 5 for the area light above.

13V-Ray materials The materials depend a lot on your 
lighting. For this example, we recommend you start with 

a simple material, like your texture and one specular layer, and 
do some tests. We can even start with a blank insect and do 
some test renders. We can use several versions of the same 
insects: one with only a blank texture and one with the final 
textures, the hair and the displacement maps. For this example, 
we add a reflection layer to get a nice glossy e�ect. You can 
play with your displacement map as a black and white map to 
add irregularity to your specular or your reflection canal.
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Expert advice from industry professionals, taking you from concept to completion
All tutorial files can be downloaded from: filesilo.co.uk/3dartist

 We usually define a rough 
volume with the Clay_Buildup 

brush and then we start 
defining the planes with the 

Polish brush  

  MIX HARD SURFACES & ORGANIC MODELLING
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DOWNLOADS
from fi lesilo.co.uk/3dartist

• Tutorial screenshots

FREE
YOUR

In this tutorial we are going to learn all of the modelling skills 
needed to accomplish a similar result to our fi nal image. 
We will also explore concept design techniques as well as 

learn how to develop an initial idea into a fi nal render. We will 
start the tutorial by learning about gathering references, 
doing the initial design, building a fi nal model and working on 
the shading and the compositing. This process is equally 
exciting and fun, but what is most enjoyable is the designing, 
modelling, shading and lighting stages. We Iove the lighting 
stage because it is when you start to see everything come 
together, and in some way it’s like when a baby opens its 
eyes for the fi rst time!

01 The brushes The main brushes we use will help to 
start defi ning the design. These are Move, Clay_

Buildup, Polish and the Clipping brushes. We will try to keep it 
simple, because at this stage we’re not looking for a fi nal 
polished model, just the design lines. So we usually defi ne a 
rough volume with the Clay_Buildup brush and then we start 
defi ning the planes with the Polish brush. Instead of using the 
standard Polish brush we will use the hPolish brush because it 
has a harder stroke and better defi nition. To use this brush you 
have to go into the Lightbox, then Brushes and then in the 
Polish brush folder you will fi nd the hPolish brush.

Mix hard surfaces & 
organic modelling

02 Maya tools Try to keep the workfl ow as simple as 
possible for modelling. In Maya the tools that we will 

use are Extrude, the Insert Edge Loop tool, the Cut tool and 
Bevel. For getting quick access to those tools, we have a custom 
shelf with all of those tools and many more just in case. It’s 
important that when you mirror a piece to put in a scale of X 
with a value of -1 to check your normals and your UVs, because 
when you mirror a piece it could be that your normals and UVs 
get reversed. So the proper thing to do after mirroring would be 
to check those two things. For the normals you can go under 
the Shading tab and check ‘Backface culling’ – this will reveal to 
you which faces are reversed.

Play with modelling and materials to create a plastic toy
MARIANO 
TAZZIOLI
Emperor toy, 2015

Software
ZBrush, Maya, 3ds Max

Learn how to
•  Do concept modelling 
•  Solve any common modelling 

issues that can occur
•  Build complex pieces out of 

simple ones
•  Do hard-surface modelling
•  Retopologise
•  Work with UV layouts
•  Clean the scene
•  Texture
•  Build shaders
•  Composite

Concept
My initial idea was doing some 
type of mechanical creature, 
but instead of doing it with a 
hard silhouette I went for a 
more organic look.

01 02

03 Clean the scene Another very important thing to do 
when you get to the point of fi nishing the fi nal model 

in Maya is to select all the pieces, then move all of the pivot 
points to the centre of the scene and hit Freeze 
Transformations. With this you will make sure that all of the 
pieces have been zeroed out. Then in the Hypershade hit 
Edit>’Delete unused nodes’, and this will delete all of the 
garbage nodes. After that simply right-click over your outliner 
and click ‘Show DAG objects only’, then in the search tab of the 
outliner type in ‘hyperView’. You can delete all the nodes that 
you don’t need as they will make your scene heavy. It’s also a 
good idea to delete your history, delete all of the layers and then 
assign the standard lambert to all of the geometries.

03
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  MIX HARD SURFACES & ORGANIC MODELLING

07 Polish Once you are happy with the 
initial rough design in ZBrush, it’s time 

to clean it up and start defining the pieces 
more and more until you get to a point where 
the model is polished enough to be 
retopologised in Maya for the final design.

04 Trigger your ideas Once you know your design 
concept, it’s time to jump into ZBrush and trigger your 

creativity. In this initial design phase you don’t need to define all 
the shapes and have it all clean – this phase is just for exploring 
and letting your hand find the shapes and volumes freely to get 
an idea of what are you looking for. The important thing here is 
to define a good silhouette or thumbnail. 

05 Pass the control to your hand As this is a purely 
creative piece you can start moving and pushing 

geometry around; the workflow that we use in this type of 
artwork is always the same. We start from a base mesh that 
was done previously, then we start to mask parts and deform 
that geometry to create the shape and volume that we are 
looking for. You can also just create a new primitive and start 
deforming it as well. 

04

07

05

06

06 Being dynamic Keep trying things until you reach the point where you like what you 
are seeing. Don’t get attached to your initial designs – keep working and changing. As 

you see in the image we are working on the process although the final modelling is not done. We 
have started doing a shading and lighting test though, and also in this phase we can decide on 
what is working and what’s not working.

08 Modelling tips In hard-surface 
modelling the pieces are not 

supposed to deform, so keep triangles where 
the topology may require it, but try to always 
have the maximum amount of quads because 
they are always cleaner. Having triangles in 
certain areas may produce dome pinching, so 
if you need to have triangles it’s better to have 
them in areas that are not too visible.

Look development
I usually do the look development of dome elements 
before putting them into the scene, for example for the 
chair I did a look development where I ended up 
developing the shader for it. It’s good practice to do this 
in a neutral lighting condition so you can see if the shader 
reacts properly to light. 08
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12

10

13

09

11

09 Prepare for exporting For the retopology stage, 
you will need to export your ZBrush model to Maya or 

3D-Coat or to whatever program you use. To do that, you 
should use the Decimation Master so that you can triangulate 
your model and optimise it so that your traditional 3D package 
can handle it. To do that, just select the piece you want and 
then go into Zplugins>Decimation Master>Pre-process 
Current and after this is done, click Decimate. The lower the 
value in the Decimaton Master slider is, the more optimised 
your model will be in the end.

10 Optimise the model Use only the quantity of loops 
that you need, for doing a hard edge you only need 

three loops. The other way of creating loops is by using smaller 
pieces of geometry which are further away from the camera 
because it doesn’t produce the same type of bevel as cutting in 
the actual geometry. This method uses creases with the Crease 
tool in Maya; this does not cut the geometry but tells the 
smooth algorithm to apply a smaller value in that edge. This 
second method is more optimised because you don’t have to 
cut, so you have fewer polygons.

11 UV mapping Once you have finished the modelling process, it’s now time for us to work 
on the UVs. They may look too complicated to do with our complex-looking pieces, but if 

you remember that complexity can be accomplished via the union of simple pieces, you will end 
up with a very complex piece made up of simple ones. You will end up working on some easy 
UVs. When you are giving a double-sided surface to a piece, instead of simply extruding, you can 
also select the border edges and extrude them so that you only end up with those edges instead 
of a back face.

12 Pose the model You can pose the 
model in ZBrush or in Maya, but this 

time we decided to pose it in Maya. Now for 
doing this you can either do a basic rig or 
simply parent the pieces hierarchically. Of 
course if you do a rig you don’t need to do a 
bind, you just parent the pieces to the joints.

13 Clean up the scene Once you have 
finished with the modelling and the 

UVs, clean up the scene so that you can start 
the shading, lighting and rendering part. First 
select all the pieces, move the pivot point to 
the centre of the scene, then freeze the 
transformations and delete the history. Now if 
you left a piece with a negative value in the 
scale then the UV will be reversed, so you have 
to review the UVs and correct them if they are 
reversed. It’s also a good idea to rename all the 
pieces with a su�x like ‘GEO’ so that you can 
filter the pieces by name. Then assign the 
lambert1 shader to the whole model and 
delete all the unused nodes in the scene.

Scripts
One important part of 
your workflow is to 
have tools that can 
speed up your work, 
so scripts can be very 
important. For 
example, you can use 
scripts for renaming 
stu� or for transferring 
UV maps to multiple 
objects at the same 
time. If you’re not very 
technical just 
download them from 
the internet, otherwise 
try having a go at 
making one yourself.

Naming conventions
A very important thing to do is to name all your stu� 
properly, because that way you have it all organised and 
you can filter your objects by name. Also it makes the 
scripting task easier. I usually put this at the end of my 
objects with ‘GEO’ but you can put any name as long as 
you follow the convention during the process.
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  MIX HARD SURFACES & ORGANIC MODELLING

14

15 17

Keep active
It’s very important as an artist to keep yourself active: 
always looking for new techniques, always trying things 
and always being inspired because that’s how you grow 
as an artist and how you learn. Always try to push 
yourself beyond your boundaries.

14 Prepare for rendering So now that we have the 
pose and it’s all prepared for starting the lighting and 

shading process, it’s time to set up the scene. We usually do 
this step in 3ds Max, so first import all of the geometry into the 
scene and decide which type of camera we want. For doing the 
scene we just modelled some props for a library which includes 
a chair, a computer screen and some books. We just wanted it 
to look as if this robot was some type of toy. This was the only 
part of the room that was modelled for now.

15 Light the scene We wanted to give the image a warm 
and colourful look, as if the light was entering the 

window from the left to give the image much more depth. So 
we started o� by using very soft and warm HDRs for the overall 
lighting. After that we situated the key light to make it so that it 
came from the left, which would be light from the Sun. And 
then we start to light areas with some bounce lights. The key 
light that was used was just a directional light and the bounce 
lights were area lights.

16 Shading and translucency Since we wanted this to be like a toy we wanted to give the 
model a plastic look. A thin plastic was created with some translucency to create a more 

appealing look. For this e�ect, what we did was create a standard VRayMtl with a violet tint. In 
the reflection a fallo� map was plugged in to provide a fresnel e�ect. Now comes the important 
part, which is the Refraction slot and the Translucency tab. In the Translucency tab just set the 
Translucency type as Hybrid, and then set the fog colour in the Refraction tab to violet. This is 
going to give the material a translucent look. For the glowing parts we created a VRayMtl. The 
material for the chair is the same as the robot but red.

17 Compositing To focus on the robot toy, blur out the background and the foreground. To 
do that, we rendered the scene in three passes: the foreground (computer screen), the 

midground (robot) and the background (library). So now we have control over the three layers. In 
After E�ects, a lens blur was applied to the background and foreground, then Magic Bullet filters 
and colour corrections were applied to the highlight areas to provide a warmer look. After that, 
we saturated the image a bit in Photoshop and painted over it with Color Dodge to bring more 
light to some areas of the scene.

16
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Techniques

T his tutorial covers the creation of the brand-new PBR 
material in Houdini via the use of the new Mantra 
features and a material shader builder. Many software 

packages are delivered with pre-made material libraries, 
materials which can be applied on the fl y. The problems are 
that many of them are crowded with options that don’t really 
fi t the situation, and that every production will end up looking 
the same. This is where this tutorial can help you out. 

At fi rst we start o   by creating a new VOP material – which 
is the Mantra material shader builder. The object of desire to 
be given a new look is a Christmas tree bauble. Therefore 
we’ll simply skip the di  use part and investigate the 
refl ections. A Christmas tree bauble has a huge refl ective 
part, so the idea is to create a layered PBR material with a core 
refl ection, an almost clear refl ection on top of it with a rim 
light e  ect and, last but not least, a third layer which covers 
dust. The core refl ection will be a fairly rough specular 
highlight that is a little bit di  erent from the norm. Instead of 
choosing one colour, the refl ection colour will come from a 
gradient to give it a more realistic feeling with manual 
colouring of di  erent refl ection angles. 

The second layer acts like a coat over the core refl ection. 
Just think of the core refl ection as a base colour. Then, a kind 
of clear varnish comes right over the base. With this tutorial 
comes an underlying Houdini scene on FileSilo, where a HDR 
map and some environment lights are in place. Some slightly 
blurred refl ections will appear on the varnish here. In addition 
we will add an intensity and simple colour parameter.

The third layer with the dust will be the most interesting to 
us. At this stage, we will work with a noise node where the 
noise will have a refl ective value as well. This layer will also 
have an intensity and colour.

For all three layers we will use special refl ection behaviour. 
A common problem in shader building is the artifi cial look of 
the material. To avoid an artifi cial look we will make use of 
fresnel blending. In Houdini the fresnel blending usually goes 
from zero to one. To imitate behaviour that occurs in most 
other software packages where the values go over one, we 
simply create a setup to let us work with any values over one.

01 Preparation for the base refl ection First we open 
the H3DA_CTB_Start.hipnc scene that is available on 

FileSilo. Let’s dive into the Christmas_Ball geometry node and 
then open up the SHOP network. Afterwards we will open the 
Tool menu and add a Material Surface Builder node which is the 
VOP material. We will call it ‘christmas_tree_ball’ and jump right 
into it. The surface output node is most important and we will 
now ignore the di  use, a step that we mentioned earlier on in 
the introduction. We must now add a PBR specular node as well 
as a multiply node. We give the refl ection node a name like 
‘Core_Refl ection’ and a roughness value of 0.6. Then, our 
multiply node will get ‘Summary_Core_Refl ection’ as a name.

Houdini 15 PBR shaders

Rainer Duda is a 
Houdini TD who 
specialises in 
creating advanced 
environments

Rainer Duda
rainer-d.de

Houdini

Matthew enjoys 
working as a senior 
environment and 
vehicle artist for Cloud 
Imperium Games

Matthew Trevelyan Johns
bit.ly/1QE7Qv4

3ds Max

With a background in 
fi ne art and games, 
Victoria’s combination 
of styles makes her 
work unique

Victoria Goldsmith
lowpolyfi sh.com

Maya

HOUDINI

Techniques

01

Our experts

DOWNLOADS
from fi lesilo.co.uk/3dartist

• Tutorial screenshots
• Project fi les
• An HDR image

FREE
YOUR

The best artists from 
around the world reveal 
specific CG techniques

Paul H Paulino is a 3D 
artist who specialises 
in texture painting and 
look development for 
the fi lm industry

Paul H Paulino
paulhpaulino.com

MARI

66

066-069_3DA_89_PT_Houdini RenderMasterclass.indd   66 09/12/2015   12:36



06

07

03

02 Time to bring in colour Now, as 
the PBR specular node is in place we 

must add a ramp node and name it 
‘ColorRamp’. The label will be ‘Core_
Refl ection_Color’. First we connect the yellow F 
output from the PBR specular with the fi rst slot 
at the multiply node – in this case the F is for 
the BSDF functions. This step is important 
because the fi rst slot will defi ne the multiply 
output. The vector output of the colour ramp 
must go into the second slot of the multiply 
node. Let’s create another node with the name 
‘Summary_Full_Shader’ and then plug it 
between the multiply output and the BSDF 
surface output. 

03 Unequal refl ections through 
fresnel The reason why some 

materials look artifi cial is because of how 
refl ections work, which is usually equal in all 
directions. To break this behaviour and give it a 
realistic touch create a fresnel node. First 
connect the kr output (refl ected light) with the 
third multiply slot. What’s left is a small control 
structure to allow values over one, as we are 
used to doing in other software packages. Let’s 
create a parameter node, a constant node and 
a divide node. Divide the constant with the 
parameter and plug the divide node to the eta 
slot of the fresnel node. 

04 Set up correct refl ection limits 
The setup for the fresnel control is in 

place, but let’s name it properly. We label the 
constant node ‘Division_Base_CR’ and give it a 
name like ‘Value_01’. The parameter node label 
will be ‘Core_Refl ection_IOR’ and its name 
‘multiplier_01’ with a start value of 4. The 
naming here is really important as we work 
with more parameters and constants. To 
ensure that we achieve a realistic look, add a 
conserve energy node and plug it between the 
last add node and the surface output node. 
Conserve energy ensures that a surface 
doesn’t refl ect more light than it has received.

05 Time to add clear varnish The 
varnish setup is quite similar to the 

base refl ection. Let’s start o�  by adding a PBR 
specular node, a multiply node as well as a 
constant node. We call the specular node 
‘Rim_Coat_Refl ection’ and we will give it a 
roughness value of 0.1. The smaller the value 
gets, the sharper the refl ection will be. Choose 
Blinn as the specular model. Now connect the 
F output of the specular node with the new 
multiply node and call it ‘Summary_Rim_
Coat_Refl ection’. Colour information will come 
from the constant. We label it ‘Rim_Coat_
Color’ and set the name to ‘RimColor’. Under 
type we choose Color. Now, let’s connect it to 
the second input of the Summary_Rim_Coat_
Refl ection multiply node. 

06 Add a natural refl ection again 
The core setup is mostly done for the 

clear varnish. But let’s add a fresnel setup to it 
again. This time it will be easy – we copy and 
paste the four nodes from the base refl ection 
and append the copy at the third input of the 
Summary_Rim_Coat_Refl ection multiply 
node. Let’s label the constant as ‘Division_
Base_RCR’ and give it a name like ‘Value02’. 
The parameter will get the label ‘Rim_Coat_
IOR’ and a name ‘multiplier2’. Then we change 
the value to 1.3. It would be good to create an 
intensity value here so we must add a new 
multiply node and a parameter node. 

07 Add an intensity control The two 
new nodes will help us to control the 

overall intensity of the varnish layer. We leave 
the label of the multiply node as it is and put 
our focus on the parameter node. Let’s call the 
new parameter node ‘Rim_Coat_Intensity’. For 
the name we use ‘rc_intensity’, and this will do 
its job but change the fl oat value to a value of 

02
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05
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something like 0.6. Now we integrate the 
setup. We must put the multiply node between 
the add node which we called ‘Summary_Full_
Shader’ and the Summary_Rim_Coat_
Refl ection multiply node. The second input of 
the multiply node will be the parameter 
Rim_Coat_Intensity.

08 Prepare the dirt layer It will be a 
bit more tricky with the dirt as we 

need an excluded noise. Let’s create now a new 
multiply node as a root for the whole setup. In 
the fi rst instance, we must add another PBR 
specular node. We label it ‘Dirt_Dots_
Refl ection’ and type in the value 0. For the 
specular model we stick to phong because it 
gives us a sharper refl ection result. Afterwards 
we connect the F (BSDF) output of the 
specular node with the fi rst input of the 
multiply node. Don’t forget, the fi rst input of a 
multiply node drives the multiply output.

09 Colour the varnish dirt We have 
the PBR specular for the dirt in place 

now. As we have a routine in this process, it will 
be easy to add a colour variation node again. 
We do this by adding a parameter node. We 
label it ‘Dirt_Dots_Color’ and set a name like 
‘crisp_color’. For the type we will choose, as we 
already know, the option colour. We’ll imagine 
that the christmas bauble hangs around in a 
dark ambience with candles and warm light 
sources. Let’s add a colour which fi ts our idea 
with the RGB values of: 0.9, 0.156 and 0.125, 
which will be a light red colour. Now connect it 
with the second input of the multiply node.

10 Add proper refl ection 
capabilities We will now do a bit of 

work before we actually start working with 
noise generators. Again we must use our 
fresnel setup which we made two times before. 
Then we can change the IOR of the dirt as well. 
We copy the setup from our core refl ection 
and paste it all the way down next to our PBR 
dirt specular. Let’s relabel the constant to 
‘Division_Base_DDR’ with a name of ‘value3’. 
Afterwards we label the parameter ‘Dirt_
Dots_IOR’ with a name like ‘multiplier3’. A 
strict naming convention is really important in 
our work because if there are the same names 
hanging around, it won’t work.

11 Control the dirt strength An 
important point is to let the dirt look quite 

realistic with a special visibility level, for 
example by adding in small scratches and dots 
from wear and tear. Therefore, we need to 
create a new multiply node and a parameter 
node to build an intensity setup. The multiply 
node, which holds all inputs from the PBR dirt 
specular, must be connected to the fi rst input 
of the new multiply node. The second input will 
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15

go to the new parameter. We label the new 
parameter ‘Dirt_Dots_Global_Intensity’ and 
give it a proper name of ‘crisp_intensity’. Put in 
a value like 1.2 to test the visibility.

12 Plug in the noise We are ready to 
fi nally add some cool stu   now. Let’s 

bring in a unifi ed noise node. As we can see 
right away it is full of options to play with. Let’s 
call the unifi ed noise node something like 
‘Noise_For_Dots’. Before we start adjusting the 
noise itself, we connect it in our big setup by 
taking the noise fl oat output and connecting it 
to the multiply node, which holds all of the 
nodes from our PBR dirt specular. To make 
something visible we need to connect the 
output of the Dirt_Dots_Global_Intensity 
multiply node with the add node called 
Summary_Full_Shader, just before the 
conserve energy node – our layering node.

13 Adjust the noise functionality 
Before we work on the noise we must 

add a rest position node. We plug it between 
the surface globals, which we haven’t touched 
until now, and the unifi ed noise. What this 
node does is basically take the input of the 
point positions to a specifi c space. In our case it 
will stay in the NDC space, which means that 
the node takes world space information from 
the points and transfers them into a screen 
space. As a result we get bigger dirt e  ects, 
which are a bit stretched around the surface.

14 Work on the noise behaviour 
Right now the noise doesn’t look like 

how we want it. To change that we jump to the 
unifi ed noise node and take a closer look into 
the parameter. What we want at fi rst is a 
higher frequency to get more detail later on in 
the noise pattern. Let’s increase the frequency 
for XYZ with a value of 75 in each. There’s one 
more thing that we have to take care of right 
now – the setup of the noise. Right now it looks 
okay but still not like spreaded noise dots, so 
what we must do is invert the noise output by 
activating the fl ag complement.

15 Finalise the setup and rendering 
The last step goes more into the look 

development process. This is where we go into 
the adjustment of the exponent level in the 
unifi ed noise setup. We keep it at a value of 8 
and when we render we should see some 
noise spots around the Christmas bauble and 
the tree. The scene is properly set up now and 
by switching from the 3D viewport to the 
render view, every change to any parameters 
will be immediately visible. Feel free to play 
around and create di  erent behaviours.

13
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O ver the next few steps we are going to create a 
photorealistic gas mask using advanced texturing 
methods in MARI. We will explain the importance of 

having good quality UVs and how strong specular maps can 
make your object look real. Additionally, we will cover some 
methods to speed up your workfl ow and explain how keeping 
an organised scene can make your life easier. Texturing 
realistic objects is a process which requires a lot of patience 
and an understanding of light and colour. It also requires a 
good eye to understand how objects work in real life.

Advanced texturing 
in MARI

MARI

01

DOWNLOADS
from fi lesilo.co.uk/3dartist

• Tutorial screenshots
• Reference photo

FREE
YOUR

01 Reference in hand In order to create a photorealistic 
asset, it’s really important to understand how materials 

react to the light, and if you have the opportunity, make sure to 
have an object that you could physically handle and observe in 
reality. Another advantage is that you can use it for photoshoots. 
We are going to have two di erent photoshoots, one for 
reference and another one for creating masks for projections. To 
do so, bring the photos into Photoshop and use Colour Range 
and Levels to extract a mask from it. Also, make sure that you 
are careful with the specular highlights.

02 Texture resolution Before starting the UV process, 
you need to determine how close the camera will get to 

the model. The general rule for fi lms is that there should be 
double the fi nal resolution of the piece in texture resolution. 
Having this in mind will let you have the exact amount of UV 
tiles. It’s also important to have a uniform texture resolution 
across the entire model, except for very small pieces. 

03 Plan out the UVs Everyone has a di erent way of 
laying out their UVs and the way that works the best 

for us is to separate them by materials. Since we like to bring the 
combined object into MARI, having everything divided by 
materials will make your life easier in the future, allowing for 
faster selections. Another important thing you must consider is 
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making sure you don’t get any stretching. A texture will stretch 
around a hard edge if that seam edge isn’t reinforced properly. 
To avoid this, add extra support edges around hard edges and 
choose your seam edges with caution.

04 Supporting maps Before jumping into MARI you 
must consider baking an edge mask in ZBrush and an 

ambient occlusion map in Mudbox. Those maps are going to 
help a lot during the texturing process, since they can be used as 
masks to drive details in specifi c areas. The edge mask also 
helps darken the edges of metal objects in the di� use and 
specular maps.

05 Di� use map The fi rst map we are going to paint 
inside MARI is the di� use. Import your combined 

object into MARI, create a new channel and make sure to check 
if your tiles have the correct resolution. Once you have 
everything, you can start using a tileable texture that matches 
your material. Then you can build up the complexity by blending 
in di� erent textures on top, aiming for interesting variations on 
the colour. By using textures such as concrete or plaster you can 
achieve distinct colour breakups, but it all depends on the 
reference you are using. 

06 Specular and roughness map After fi nishing the 
di� use, you can duplicate the channel and start 

converting it into a specular map. You can start by adding a 
luminance adjustment on top of everything to get rid of any 
colour information. After that you should tweak each layer and 
try to get the best value range possible. The roughness map is 
going to do a similar thing to the specular, except the tonal 
values don’t determine the specular intensity, they indicate 
specular highlight softness. Using V-Ray, white areas in the 
roughness will create a tight specular hit, and black areas a 
broader and di� used specular. 

Complexity requires organisation 
During the texturing process in MARI you can end 
up with a crazy amount of layers and channels. An 
organised scene is vital to making your life easier, so 
create a name convention that makes sense and use 
it for everything. Another tool in MARI that can help 
your organisation and also speed up your workfl ow 
is selection groups. This way you’ll be able to work 
without worrying about losing track of your 
materials and textures.

04

05

06
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Build a texture library
A texture library is one of the most important tools in the texture painter toolkit. After 
each project, ensure you collect and save all the textures that you have used. Be 
organised and separate everything properly; this step can save you a lot of time in the 
future. Also, get used to creating tiled textures from your regular textures and create 
a folder just for them, and create a separate one for masks that you’ve created.

07 

0809

07 Bump and displacement maps For the bump 
map you can start by using textures that match your 

reference and tileables, but make sure you tweak those by 
adding a breakup texture as a mask. This way you will be able to 
achieve a more believable surface detail. Sometimes you may 
need to break the silhouette of your object – that’s when a 
displacement map comes in handy. You can create an 8-bit 
displacement in MARI, where white areas will be displaced 
outwards and black areas won’t be a�ected.

08 Achieving realism After working successfully on the 
broad aspects of your object, make sure to spend some 

time adding details such as decals, numbers, seams and so on. 
This refining stage will make your object even more interesting 
and realistic. Also, used objects get dusty and dirty; you can 
apply these details on a separate layer using a smudge tileable 
texture. You can also use the AO map, created previously as a 
mask, to drive the dust and dirt into occluded areas. Avoid 
overdoing it though, otherwise you will lose all the work that you 
did previously.

09 Look development Now that you are done with all 
your maps, it’s time to move into V-Ray and start the 

look development phase. Keep the light setup simple and use a 
good HDR. Colours can be distracting in the beginning, so you 
can begin by using only your bump and specular maps to find 
the correct values. Make sure you adjust your materials 
separately and use blend materials if you need. Keep going back 
into MARI to adjust your textures if you judge it to be necessary. 
Once you’re happy, just press render.

 You can use the AO map, created 
previously as a mask, to drive the 

dust and dirt into occluded areas  
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  TECHNIQUES

W ithin the realm of videogames, often the 
beautifully rendered, expansive environments or 
fantastically realistic leading characters steal the 

show. But just as important, although sometimes overlooked, 
are the incredibly detailed tools, gadgets and props that also 
enjoy a considerable amount of screen time. Often a studio 
will break art tasks down into di� erent departments, with 
dedicated environment, character, vehicle and prop teams. 
The aim of this tutorial is to outline the processes employed 
by an artist working on a highly detailed prop asset. A typical 
example might be the highly detailed AK-47 you hold as a 
character in a fi rst-person shooter, or a mysterious, 
collectable artefact found in a lost tomb that the player can 
later view in detail. The subject of this tutorial is an impact 

Construct a real-time 
videogame asset

3DS MAX, QUIXEL

01

DOWNLOADS
from fi lesilo.co.uk/3dartist

• Tutorial screenshots
• Turntable video
• Texture maps

FREE
YOUR

wrench, or wheelgun as it’s also known, which is a tool 
typically used by professional pit crews when changing tires. 

With a solid and sturdy design, and plenty of interesting 
surface details and materials, this prop will provide many 
interesting opportunities to learn and refi ne your skills when 
trying to re-create it. This tutorial will identify each of the main 
steps involved in the pipeline before giving an outline of the 
processes required. Annotated images will also help guide 
you to completing each step before moving onto the next. 
Just as it is in the professional industry, it will be dependent 
on your own skill level and experience as to how long each 
step takes you to complete, and so with that in mind, try not 
to rush through this guide. Instead, take your time to learn, 
practise and, most importantly, enjoy the process. 
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01 Gather references Gathering suitable reference is 
one of the most important preliminary steps when 

beginning any project. It’s important to not only develop a 
familiarity with the appearance of the item, but also to learn a 
little about its construction, use and function. This is important 
because the more you are able to learn about this object, the 
more informed your modelling and texturing choices will be. 
Using sites like Google, Pinterest and Flickr we’ll collect images 
and information about each part of the impact wrench and 
create a mood board to help us generate ideas. 

02 Create a blockout Creating what is referred to as a 
blockout mesh is an essential part of the modelling 

process; the aim of this step is to capture the rough proportions 
of the asset using simple primitive shapes and low detail 
meshes. At this stage keeping the meshes relatively simple will 
allow us to easily manipulate them. Using the basic modelling 
tools within the vertex, edge and polygon selection modes, edit 
the meshes with a focus on capturing the large masses of the 
object and their relation to one and others. With this done, we 
will no longer need to worry about general proportions in the 
next stage and we can focus more on details. 

03 High-poly model We’ll now move on to creating a 
detailed version of the asset that we’ll later use to 

generate a normal map texture from. The type of modelling 
used at this stage is known as subdivision modelling: the 
workfl ow involves creating a mid-level mesh that accurately 
captures the silhouette and details of the subject, before 
applying the TurboSmooth Modifi er within 3ds Max to smooth 
out all of the facetted polygons. The TurboSmooth Modifi er 
works by subdividing each polygon once horizontally and once 
vertically, and smoothing the silhouette of the object in doing so. 
Unfortunately this can result in a loss of hard edges and so 
additional ‘support loops’ are required to control the e� ects of 
the smoothing. As you can see, adding a TurboSmooth to the 
model shown in fi gure A results in an overly smooth mesh as 
shown in fi gure B. However, with additional support loops added 
in fi gure C, the resulting TurboSmoothed mesh maintains its 
silhouette and tighter details as shown in fi gure D. With this in 
mind, it’s now simply a matter of modelling each part of the 
object in turn. This can take some time to do, but the quality of 
the fi nal asset is often determined by the time and e� ort that is 
spent at this stage.
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Prepare meshes for export with xNormal
We’ll be using a free program called xNormal to generate a normal and ambient 
occlusion map, but fi rst let’s prepare the meshes for the program. For the high-poly 
mesh, space the meshes out a little and add a bright vertex paint modifi er to each 
part that represents a di erent material, as shown in fi gure A. For the low-poly, again 
space out the parts so that they lie on top of their high-poly counterpart and then add 
an Edit Mesh modifi er and a Projection modifi er to the object. In the Projection 
modifi er use the ‘push’ option to expand the cage so that it encompasses the 
high-poly model. With xNormal installed, you’re now ready to export these two 
meshes as SBM fi les using the options shown in each corresponding dialog box.

04 

05

06

04 Low-poly model Now it’s time to create the 
low-poly version of the asset. This model will need to 

adhere to a strict polygon limit and will also need UVs to enable 
us to generate normal map information from our previously 
created high-poly mesh. Creating a duplicate of the high-poly 
mesh, we’ll now simply begin to remove some support loop 
edges, cylinder segments and fi ne details like modelled text and 
small indents until the low-poly model is around 12,000-13,000 
triangles. Figure A and B show examples of the low- and 
high-poly model for comparative purposes.

05 UV unwrapping In order to generate a normal map, 
the low-poly mesh will need UVs. These UVs must fi t 

within the 0-1 space within the UV Unwrap Editor and must not 
overlap at all. To make the process of unwrapping easier, you can 
use a free plugin called TexTools, though the standard 3ds Max 
unwrapping tools are also su�  cient for the task. One very useful 
function that TexTools has is the ‘Smoothing Groups from UV 
shells’ option found under the Tool menu. Clicking this button 
when our UVs are fi nished will apply smoothing groups to our 
low-poly mesh that will ensure the normal map that is generated 
works well with the mesh. Figure A and B show the fi nal UV 
layout and the text tools dialog boxes.

06 Texture maps with xNormal With the high- and 
low-poly models exported, you’re now ready to 

generate the normal map texture as well as ambient occlusion 
and height maps – these texture maps will be integral to the 
texturing process covered in the next step. As well as being free, 
xNormal is extremely easy to use. First add high- and low-poly 
mesh SBM fi les to the corresponding tabs labelled on the 
right-hand side of the program interface. In the Low Poly tab 
ensure Use Cage is ticked and in the Baking options tab select 
the Normal map option, choose an Output fi le location and hit 
Generate Maps. Repeat this process to generate an ambient 
occlusion map and a high-poly vertex colour map. 

 UVs must fi t within the 0-1 space 
within the UV Unwrap Editor and 

must not overlap at all  
76

074-077_3DA_89 PT RealTime GameAssets.indd   76 09/12/2015   12:45



All tutorial fi les can be downloaded from: fi lesilo.co.uk/3dartist

07 Texture using Photoshop and DDO In a 
production environment deadlines are critical, and 

using a program like Quixel’s DDO can make the texturing 
process dramatically more e�  cient. Simply load textures and an 
OBJ of the low-poly mesh into the appropriate slots in the Base 
Creator window and set the options as shown in fi gure A. 
Pressing Create Base will now take us to the editor. Loading the 
3D viewer, you can see a preview of the mesh and holding C will 
display the vertex colour ID map generated. Holding Shift and 
clicking on any of the colours will bring up the Material Browser 
window as shown in fi gure B, where you can select and apply 
materials to each part of the mesh.

08 Fine-tune the textures in DDO With all basic 
material assignments made to the asset we can now 

begin to fi ne-tune them using DDO’s built-in options. With each 
new material assignment a material group has been created in 
the layer tab shown in fi gure A. Clicking on the mask icon for a 
layer, a Fine Rust layer for example, brings up the Dynamask 
Editor shown in fi gure B. Within this editor you can either 
choose from a selection of masks to control how the rust is then 
applied to the asset and view the changes you make with the 
sliders in the 3D viewer. With a little time and patience, 
fi ne-tune all of the materials this way until you’re happy with 
how the fi nished textures look.

09 Presentation in Marmoset Toolbag Now that 
you’re happy with the asset’s appearance in the DDO 

viewer, use Marmoset Toolbag to capture a fi nal render. Within 
Marmoset you can easily load the mesh and use the default 
shader and plug textures into their corresponding slots as 
shown in fi gure A. Using the Sky tab, you can choose from a 
number of HDRI maps for ambient light and by clicking on the 
Light Editor window, you can create an additional, shadow 
casting light as shown in fi gure B. Finally, you can set the 
Capture settings as shown in fi gure C to make a really large 
image that you can later downsize in Photoshop to fi x any 
aliasing issues.

Presentation tips
While taking screenshots within Marmoset Toolbag, using the default HDRI 
backgrounds is a nice way to present the asset; we always like to add a little context 
to our work, in order to really sell the idea we’re trying to present. In this case we’ll 
present the fi nal image as if the impact wrench has been left on the fl oor of a Formula 
1 pit lane. This can be achieved with a simple textured plane and a few additional 
models, like a hose and some bolts to add a little interest. After capturing the image 
we add some subtle photographic fi lters and we’re ready to call this project done!

08 

09 

07

 A program like Quixel’s DDO can 
make the texturing process 

dramatically more e�  cient  
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T his tutorial gives a stylised approach for modelling a 
3D mask in Maya and Illustrator. You will learn to 
model a mask that looks like it has been hand made 

from paper. Sometimes it can be di�  cult to create curves and 
organic shapes in Maya, but this tutorial combines Illustrator’s 
‘paths’ with Maya to convert them to polygons. This is a 
chance to have fun without some technical limitations and 
create some cool-looking art. 

01

DOWNLOADS
from fi lesilo.co.uk/3dartist

• Tutorial screenshots
• Texture maps
• Photoshop fi les

FREE
YOUR

01 Sketch out a concept The fi rst thing to do before any 
project is to draw some rough concepts out to plan your 

idea. To jump straight into a project without planning can make 
the design su er and waste a lot of time. You could do some 
rough sketches in a sketchbook fi rst then work them up in 
Photoshop to play with the concepts and colours. The looser the 
better, don’t be afraid to try lots of variations. Make sure you 
have a solid design idea before you take it a step further.

02 Take the chosen design to Illustrator With your 
design chosen, it’s time to tighten it up Illustrator. 

File>Place (name of image) into Illustrator. Make sure that you 
put the concept into a locked layer by clicking the empty box on 
the layer. It is also a good idea to run a ruler guide down the 
middle of the mask so that you can see it is symmetrical. 

03 Vector the design Now use the pen tool to draw out 
the di erent sections. Try to use di erent layers for 

each di erent section to keep organised – it helps to imagine 
building up the layers in 3D. Make sure the pen is drawing the 
outline and not fi lling in the shapes. Check the fi ll swatch is on 
‘none’ and the ‘stroke’ has a colour. Only draw half of the mask 
because you can fl ip it when it’s drawn. Use the Convert Anchor 
point tool to alter the paths, switch between that and the Pen 
tool. Add or minus the points where you see fi t.

Use the layers 
in Maya
It is really useful to 
make use of the layers 
in Maya; a lot of people 
forget that they even 
exist. On the 
right-hand side below 
the Channel Box editor 
under Display are the 
layers. You can toggle 
between which 
visability you want. V 
means visible, T 
means template and R 
will lock the item that’s 
been added. Click on 
the layer with the 
items selected and 
then click ‘Add 
selected objects’.

Use the layers 
in Maya
Use the layers 
in Maya
Use the layers 

It is really useful to 
make use of the layers 
in Maya; a lot of people 

Make a papercraft 
mask in Maya

MAYA, ILLUSTRATOR
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04

04 Flip the shapes When you have 
drawn half of the shapes, fl ip it to 

make it symmetrical. Just draw one leaf, as you 
can duplicate them later in Maya. Then you 
can copy and paste the shape, and select it by 
using Object>Transform>Refl ect. Flip one 
object at a time now instead of multiple paths, 
as some may need tweaking. Make sure all the 
paths are closed by clicking Object>Path>Join, 
as Maya will struggle converting them into 
curves if they are open. 

05 Export from Illustrator to Maya 
When you have your paths cleaned 

up and symmetrical it’s time to export the 
mask to Maya. Make sure you delete anything 
that is no longer needed in the layers – it’s 
advisable to save this as a di� erent fi le just in 
case. Make sure all the paths are closed and 
that there are no duplicate curves. Now go to 
File>Save As and name the document. Change 
the Illustrator version to Illustrator 8.

06 Curves to Polygons Open up 
Maya and go to Create>Adobe 

Illustrator>Object>Select Bevel>Create to 
convert the curves to polygons. If there are any 
issues it is because of unclosed paths or 
duplicate curves. The path might not be dead 
centre at this point, so just go to 
Modify>Centre Pivot and place it in the middle 
of the grid. Click on the mesh with 
Modify>Separate and then you can move the 
polygons forwards/backwards until you are 
happy with the placement. Move the leaf at the 
top of the mask in the middle then duplicate it 
and rotate it around the mask. Use the shortcut 
Ctrl/Cmd+D for this. Duplicate half, then with 
all the leaves selected click on Edit>Group (this 
will make it easier to transform). Then use 
Mesh>Mirror Geometry for the other side. 
Repeat for the next two leaf layers but make 
the leaves that are behind bigger. 

07 UV mapping/texturing Now 
select an item and go to 

Polygon>Create UVs>Planar Map. For this 
project the texturing will be block colouring so 
you can cheat a little and just planar map the 
front faces and hide the side faces (by shrinking 
the UVs really small). All of the items are 
separate and will be block colours so you won’t 
see any seams. A nice time-saver is to transfer 
UV sets to other polygons that are the same 
mesh, like the leaves for example. In the 
Polygon menu select a polygon (one that’s UV 
mapped), select another polygon and go to 
Mesh>Transfer attributes. When you are 
happy with your UV map, take a UV snapshot 
and take it into Photoshop to texture.

08 Lighting/rendering Use a 
directional light and maybe the odd 

point light to light up the front. Render face on 
like a mask and use a square render size about 
2048x2048. You can either render in Maya or 
use an external program, whichever you feel 
the most comfortable with. We will render in 
MODO with a setup of a simple directional 
light front on and a light behind to give it some 
back lighting. Render it out as a PNG so that it’s 
an alpha (see-through).

09 Photoshop editing When you 
have your rendered image, take it into 

Photoshop. Feel free to alter the brightness/
contrast and the colour levels until you’re 
happy with the colours. Choose a 
complementary background to go underneath 
the mask. Then use the Rectangular Marquee 
tool and select half of the mask, dead centre. 
Go to Image>Adjustments>Brightness/
Contrast and bring the brightness down on one 
side. This will give the illusion that the mask 
comes to a point in the middle. Then select the 
mask layer and put a drop shadow underneath 
just to give it a bit more depth. Repeat for the 
ears so that they look creased. The last 
fi nishing touch to give an authentic paper look 
is to add a texture on top. Search the internet 
for a sugar paper texture or something similar, 
put the layer on overlay/soft light and play 
around with the opacity.
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  CHILLBLAST FUSION RENDER OC M4000
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Chillblast Fusion 
Render OC M4000

In astronomy, a planet is said to exist in a 
‘Goldilocks Zone’ if it’s just the right distance 
from its parent star, with mild surface 

temperatures that ensure water is in a liquid 
state. Not too hot, not too cold.

The same idea could loosely apply to the 
sweet spot for general-purpose 3D 
workstation confi gurations. You want a 
processor with enough CPU cores for great 
performance in multithreaded rendering 
applications like 3ds Max, but not at the 
expense of clock speed for single-threaded 
applications that (still) make up the bulk of all 
computer software. You want a powerful GPU 
for tasks that are accelerated by CUDA or 
OpenCL, but at a reasonable budget.

Chillblast’s Fusion Render OC has such a 
specifi cation, one we would consider to be 
perfectly suited for mid-range rendering.

It has an Intel Haswell-E Core i7-5820K 
processor – a six-core chip, so you’re getting 
roughly a 50 per cent performance 
improvement in multithreaded applications 
over standard quad-core processors. And this 
chip has been overclocked to 4.2GHz, a 
mighty increase over its 3.3GHz default 
speed, all thanks to the Corsair Hydro H100i 
GTX all-in-one liquid cooler.

On top of this, it’s sporting Nvidia’s swanky 
new Quadro M4000 8GB Maxwell-based 
graphics card, which we reviewed in issue 87, 
concluding it o¡ ered a lot of bang for your 
buck. To recap, Nvidia’s new generation of 
Quadros sticks to the same 28nm process of 
the older Kepler models, rearranging the 
furniture for a strong boost to some areas of 
3D performance, especially OpenCL.

Topping o¡  these main components there’s 
32GB worth of DDR4 memory; an Asus 
X99-A motherboard; a 512GB Samsung 
SM951 PCI-Express SSD that is capable of 
some utterly insane performance; a 2TB hard 
disk; 650 watt power supply and fi nally 
Windows 10 Professional.

Chillblast has gone for a Fractal Design 
Defi ne R5 chassis, with an internal build that’s 
as well built and tidy as you would expect 
from a major PC vendor, with no messy 
cabling to obscure access to the internals.

It’ll set you back £2,500, which is hardly 
pocket change, but expensive hardware is an 
unfortunate aspect of 3D design, and when 
you consider what you’re getting, it works out 

to be fantastic value. Although no single 
component here is the absolute best in class, 
if you want a workstation with a more 
powerful eight-core processor and a beefi er 
GPU you’ll need to dig deep into your wallet.

What’s really important is that with 
modern hardware and lower prices, you’re 
getting the same level of rendering 
performance from a £2,500 machine that 
would have set you back £4,000 a year ago.

The proof is in the benchmark results. The 
Fusion Render OC chewed through the 1080p 
Underwater 3ds Max test in 9 minutes 11 
seconds. This result isn’t quite as quick as 
some systems we’ve tested with eight or 
more processor cores, but still a lot faster than 
any system with a quad-core chip, including 
Intel’s latest Core i7-6700K Skylake 
quad-core processor.

In SPECviewperf the M4000 roughly 
matched the performance we recorded in our 
test system. It’s a £750 GPU, but it matches 
or even beats the 3D performance that the 
previous-generation Kepler-based Quadro 
K5200 managed, which cost £1,500 – yet 
another boost to the all-round value of the 
Chillblast Fusion Render OC.

Meanwhile, in Cinebench, we recorded a 
score in the multithreaded CPU test of 145.14 
– again a result that doesn’t beat the 
eight-core Xeon systems we’ve reviewed, but 
it’s a slim gap for far less cash.

The only conclusion is that the Fusion 
Render OC o¡ ers the best relative value of 
any system we’ve reviewed, given its 
capability. It will get by just fi ne with even the 
most detailed rendering jobs, o¡ ering much 
better performance than a quad-core 
workstation, while remaining within most 
realistic budgets.
Orestis Bastounis

Chillblast hits the right balance for general-purpose rendering 
with a six-core Intel processor and Nvidia Quadro M4000 GPU

component here is the absolute best in class, 

he proof is in the benchmark results. The 
Fusion Render OC chewed through the 1080p 

more processor cores, but still a lot faster than 

matched the performance we recorded in our 

score in the multithreaded CPU test of 145.14 

eight-core Xeon systems we’ve reviewed, but 

capability. It will get by just fi ne with even the 

with a six-core Intel processor and Nvidia Quadro M4000 GPU
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MAIN The PCI-Express Samsung SM951 SSD can manage 
sequential read speeds above 2000MB/sec

BOTTOM LEFT The Nvidia Quadro M4000 uses the new 
Maxwell architecture

BOTTOM MIDDLE A high-performance all-in-one liquid cooler 
makes all the di� erence to achieving a stable overclock

BOTTOM RIGHT An overclocked six-core processor o� ers a 
formidable mix of single and multithreaded performance

BELOW The Fusion Render runs extremely quietly, even when 
put under load

Verdict

Summary

The performance of last year’s typical £4,000 worksta-
tion can now be had for £2,500

Price   £2,500
Website  chillblast.com
CPU  Intel Core i7-5820K (4.2GHz)
GPU  Nvidia Quadro M4000
RAM  32GB DDR4
SSD  Samsung SM951
Cooler  Corsair H100i

Essential info

Features
Performance
Design
Value for money

 You’re getting 
the same level of 

performance from a 
£2,500 machine 

that would have set 
you back £4,000 a 

year ago  
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The inside guide to industry news, 
VFX studios, expert opinions 

and the 3D community
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088 Community news

Trojan Horse 
was a Unicorn
After a few concerns over the 
popular festival’s future, we fi nd out 
whether THU will return in 2016. 
Plus, we revisit bluegfx expo

090 Industry news

NUKE 10
The Foundry reveals plans to launch 
a new rendition of its compositing 
solution in 2016, plus Poser goes 
PBR and Kinect mocap levels up

092 Advertorial

The VFX Festival
In a sponsored message, Escape 
Studios, part of Pearson College 
London, reveals why its 2016 
festival line-up is so special 

094 Social

Readers’ Gallery
The latest images created by the 
3dartistonline.com community

To advertise in The Hub please contact Simon Hall on 01202 586415 or simon.hall@imagine-publishing.co.uk

Andres Luis, co-founder of Trojan Horse 
was a Unicorn

 Before we say ‘yeah 100 per cent 
sure we will do 2016’, this time I want 
everything done in a di� erent way so 

we can [do] a better job  
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For the most part, due to severe financial concerns, the 
decision about whether or not there will be another 
chapter was left up in the air during the closing 

ceremony of Trojan Horse was a Unicorn 2015 (THU) – the 
highly regarded digital arts festival held annually in Troia, 
Portugal. But after a deliberation period, THU‘s cofounder 
Andres Luis and ambassador Scott Ross have now reached a 
decision… well, sort of. “It’s not sure that we will do 2016,” 
revealed Luis at the THU meetup held at Gnomon HQ in LA. 
The meetup was a chance for the team to discuss the 
problems THU faces and unveil their intentions for the 
festival, THU TV and what’s next for the tribe. 

“To put on THU is somewhere in the neighbourhood of €1 
million,” Scott revealed while discussing the financial 
problems. Hampered by the decision to keep the family 
feeling of the event, which means keeping ticket numbers 
very limited, they have opted to look at more sponsors as 
well as asking existing sponsors to dig deeper. “If we do 
2016, I was convinced to prepare what should be the next 
step, I spent the last two months organising what should be 

Is the end in sight for 
Trojan Horse?
The tribe gathers at Gnomon’s Hollywood campus in LA 
to hear about the future of Trojan Horse was a Unicorn

the next generation of THU. Having more sponsors brings a 
responsibility of not killing the vibe,” Luis surmised.

Another source of funding, THU TV was aimed at people 
who may not have tickets and couldn’t participate, and to 
expand the tribe worldwide but keep the event intimate. “If 
we do the event again, THU TV will have some upgrades” 
Luis said. Referred to as THU TV version 2, it will contain 
exclusive new shows being added over the remainder of the 
year with over 40 hours of content split into 12 di�erent 
shows. This will include shows like ‘Inside the Industry’, 
interviewing recruiters asking them what they are looking for; 
‘Sketchbook’, looking inside artists’ sketchbooks; and ‘Speed 
sculpting lab’, comprising timed modelling battles between 
artists. Scott explained, “The concept of THU TV is now 
moving in the direction of being like a broadcast station; it 
will have select programming directed at your interests and 
desires from a creative and inspirational point of view.” 

The event is still being planned, but tickets go on sale 2 
January and will continue to be capped at 500 tribe 
members. The price will increase €100 to €600 plus taxes. 
No early bird tickets will be available but there will be flexible 
payment plans such as a monthly plan. The pioneers, the 
people who went to the first event (THU 2013), will be able 
to purchase tickets for €400 plus taxes. “Before we say ‘yeah 
100 per cent sure we will do 2016’, this time I want 

Content from THU TV such as ‘Inside the 
industry’, ‘Speed Sculpting Lab’ and 
‘Sketchbook’ were premiered at the meet up

  COMMUNITY NEWS
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It will happen in September 
2016, but we don’t know the 

venue and we are hoping we get 
the support necessary 

Scott Ross, THU ambassador

www.3dartistonline.comGet in touch… @3DArtist Facebook.com/3DArtistMagazine

bluegfx expo 2015
The expo impresses yet again with a host of 
professional talks

This year’s sixth annual bluegfx expo was 
held at the Coin Street Centre in South 
Bank, London. “We couldn’t be happier 
with how the day went, with over 200 
visitors enjoying talks, presentations, 
demonstrations and informal 
consultations with leading designers and 
manufacturers from the world of 3D 
design and entertainment software,” said 
Jo Calverly of bluegfx. “There were talks 
from some of the most exciting, 
innovative creative studios out there 
including Hamilton+Kidd, Squint/Opera, 
Blue-Zoo, Framestore and MPC. Stuart 
Penn from Framestore gave insight into 
some of the complex VFX sequences 
used in the making of Warner Bros’ Pan, 

and Marco Romeo talked about the work 
performed for the rigging of Arnold 
Schwarzenegger in Terminator Genisys.” 

There were also a range of product 
presentations at the expo, including 3ds 
Max, Maya, Shotgun and Stingray from 
Autodesk; V-Ray from Chaos Group; 
RealFlow from Next Limit; Adobe CC and 
ZBrush. “The bluegfx expo was a great 
day – there was a fantastic mix of 
presentations from design studios and 
manufacturers, as well as product 
demonstrations. The event was 
seamlessly run and the bluegfx team were 
excellent hosts. I’ll look forward to 
attending next year’s expo!” said Lee 
Brown, director at Valkyr Media Ltd.

Autodesk’s Alex Horst gave talks on the latest design animation 
workfl ows and procedural workfl ows with 3ds Max

everything done in a di� erent way so we can [do] a better 
job,” said Luis. 

A new location is also on the cards “We know that we will 
be in Europe, that’s for sure,” Luis revealed. “There’s a lot of 
reasons we want to continue to do it in Tróia – it’s a great 
location. But I have to be honest with you, Portugal has really 
turned the other cheek – they have not been supportive of 
the event,” Ross confi rmed.

With sponsorship deals still being negotiated, and the 
potential of THU TV in the balance, the event’s future still 
remains optimistic, as Ross explained. “Assuming everything 
works the way we hope it’s going to work with sponsors, and 
assuming the tribe responds with ponying up an extra €100 
for tickets, it will happen in September 2016. But we don’t 
know the venue and we are hoping we get the support 
necessary. The reason we are selling tickets in January is 
there’s a need for cash fl ow. If the event does not happen we 
will return the money.”

THU TV version 2 
is a new concept 
from the Trojan 

Horse was a 
Unicorn festival
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The upcoming release of NUKE 10 brings with it 
ray traced rendering directly into NUKE’s 
compositing environment via the new Ray 

Render node. It displays in a Scanline format and has a 
lower memory footprint, improved motion blur and 
shadows, point light shadow output, faster non-linear 
spherical projection and extended support for 
refl ections and ambient occlusion. 

An overhaul of the RotoPaint node promises more 
stability and, in an e� ort to remove existing bottlenecks, 
enables more paint and clone strokes, letting you do 
more work inside just one node rather than having to 
use several nodes. The new Smart Paint toolset for 
NUKE X is a group of nodes that provide new 
workfl ows for adding textures and plates to image 
sequences using motion vectors that you can generate. 
It is tailored to simplify any cleanup and beauty work, 
which are typically laborious to do.

Some of the core compositing enhancements 
implemented by The Foundry include changes to the 
way NUKE’s localisation works, and a more informative 
user interface. Speed improvements take advantage of 
Nvidia GPU support, enabling you to use two GPUs. 
There is also AMD support for newer MacBook Pro 
laptops as well as a GPU-driven vector blur for faster 
processing. NUKE STUDIO will enjoy timeline 
improvements (see left).

HAVE YOU HEARD? Apple was behind the mysterious acquisition of real-time motion capture technology fi rm Faceshift

NUKE 10 for 2016
Slated for release early next year, the focus is on 
stability, bug fi xes and industry standard updates

The Ray Render node adds a 
ray traced rendering engine 
to all versions of NUKE

Poser release 
adopts PBR 

Poser 11 has been upgraded with an integrated 
physically-based rendering solution

The visual quality of your work is set to 
improve with the introduction of 
physically based shading and rendering 
into both new Poser fl avours. SuperFly 
is built on Blender’s Cycles render 
engine, and is compatible with existing 
FireFly materials and the new SuperFly 
material system. The Pro version 
supports Nvidia CUDA GPU-assisted 
rendering. For graphic novel and anime 
artists, the Comic Book Preview mode 
now exists in one panel and sports 
automatically generated OpenGL ink 
lines, which you can then adjust the 
weight of and animate. A welcome 
dose of workfl ow enhancements 
(some Pro only) include adaptive 
rigging using Morph Dependent Joint 
Centres, smooth weight painting, 
Morph Target options at subdivision 
level, Alembic export, game dev 
features for asset creation with FBX 
import and export, and Windows 
Kinect support. Area lights with soft 
shadows, caustics, volumetric 
materials and layered materials for 
adding tattoos or scars have also been 
added to the new release.

NUKE STUDIO enhancements
Timeline improvements include a new Chroma 
Keyer for pulling both blue and green screen, 
core and soft mattes in real time with Despill 
Parameters for corrections, audio scrubbing to 
more easily match sound to footage, Soft 
E� ects for the Color Correct node, more stable 
playback, swifter transcoding and faster 
QuickTime creation.

Version 11 and version Pro 
11 receive SuperFly 
renderer and new features
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The game developer signs a 
licence agreement to use 
IKinema’s RunTime
IKinema has expended its Japanese presence by 
licensing Square Enix its award-winning fl agship 
middleware RunTime, which lets studios 
procedurally animate characters and multi-
limbed creatures of any shape or size during 
gameplay, resulting in characters that respond to 
the game world around them with 100 per cent 
accuracy and more natural and life-like 
movement. “IKinema’s skill in delivering realism 
and believability in procedural animation is 
particularly suited to game development,” said 
IKinema founder and CEO Alexandre Pechev. 
The technology lets developers apply universal 
animation standards to multi-platform titles 
from mobile games through to triple-A titles, 
and will be used in upcoming games.

Real-time HD Kinect plugin for Xbox 
One couples with iClone 6 Pro to 
provide a mocap solution
Building on the success of its original Kinect mocap 
plugin for Xbox 360 and Windows, Reallusion has 
released an HD Xbox One version. When used with 
iClone 6 Pro it turns your Xbox One into a mocap studio 
without needing a marker suit. After the initial capture 
session you can then use iClone’s motion editing toolset, 
which includes HumanIK and motion layering, to adjust 
your captures before exporting characters and motions 
into game engines or other 3D applications in FBX 
format. New features include 1080p camera with 
increased fi eld of view, additional trackable skeleton 
joints, unparalleled tracking accuracy and improved 3D 
visualisation for better fl oor and feet contact.

91

New pre-vis renderer creates 
hardware rendered panoramic 
360-degree images using OpenGL
With PlayblastVR, by Dover Studios co-founder 
Andrew Hazelden, you can create immersive 
hardware based pre-vis renderings of Softimage 
scenes in 14 di� erent panorama formats. Scene 
elements such as animated polygon and NURBS 
geometry, lights, ice, hair and fur, cloth sims and 
procedurally generated shading networks are all 
supported. Completed sequences can be sent to 
Oculus Rift or viewed using standard playback 
tools. Direct panoramic rendering output to 
YouTube 360 and Facebook 360 video with 
automatic metadata embedding, and to Google 
Photo Sphere is supported.

DID YOU KNOW? Evermotion is holding an arch-vis contest. The entry deadline for the competition is 26 January

Bringing you the lowdown on product updates and launches

PlayblastVR 1.0 
for Softimage

Square Enix gets RunTime licence

Reallusion 
upgrades Kinect 
Mocap plugin

Software shorts
HitFilm 4 Pro
HitFilm 4 Pro introduces Normal and 
Bump mapping, plus Cook-Torrance 
shading, dynamic refl ections, di� use 

lighting and global AO that casts between di� erent 
3D layer types. There’s also Alembic support and a 
new animation value graph plus particle system and 
editing updates. Boris FX’s titling plugin, 3D Objects, 
comes included for free. HitFilm4 Pro will be $349.

SketchUp 2016
Workfl ow improvements form the 
emphasis of the 2016 release. There’s 
new functionality to the inference 

engine; the texture library has been overhauled and 
expanded; and LayOut has a new C API, multilayer 
groups and more. Trimble Connect is now 
integrated for pro users too. The non-commercial 
version is free, while the pro version is $695.

BulletFX 3.0
A raft of new features have been 
included in AlphaVFX’s Bullet 3.0. 
The GPU-accelerated multiphysics 

engine plugin for 3ds Max gains GPU FLIP fl uids 
with a foam solver, an OpenVDB fl uid mesher, a 
GPU granular solver, a di� erential FEM solver that 
includes a muscle solver and tetrahedralise solver, 
BGEO caching and more. BulletFX will be $260.

Reallusion’s Mocap plugin for 
Xbox One Kinect is now 
available for £79.99

Square Enix has released titles including Final Fantasy, 
Dragon Quest and Tomb Raider
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Brought to you by Escape Studios, part of Pearson 
College London, the VFX Festival 2016 will feature 
speakers from the world’s most recognised studios 

across VFX, animation and games; it will delve into and 
discuss the convergence that is taking place across the 
creative industries. The festival will consider how the 
di�erent disciplines are coming together and the 
opportunities that have been created as a result. 

The Mill will kick-o� the festival, presenting on 
Augmented Reality, Virtual Reality and discussing the Google 
ATAP Project, with Hamilton+Kidd providing a supporting 
presentation on Virtual Reality and 360-degree technologies.

MPC will show how the innovative EarthToMars tool 
created for The Martian (Twentieth Century Fox, Ridley 
Scott) combined innovative technology and the perfect 
location shoot to develop photoreal environments. The CG 
team enhanced the desert-scape adding additional rocks, 
craters and mountain ranges to construct a believable Mars 
world, here on Earth.

Further presentations will come from Rushes who will be 
discussing the amazing motion graphics featured in the new 

The VFX Festival 2016
Escape Studios’ annual CG celebration returns in 2016 with a star-studded line-up of  

games, animation and VFX guest speakers 
James Bond film Spectre. World-renowned animation studio 
Aardman will be talking about all things animation. Lastly, 
Climax Studios will be representing the world of gaming, 
talking about its contribution to the very successful games 
series Assassin’s Creed.

Industry convergence is creating brand new challenges 
and opportunities across all disciplines, where games artists 
are helping filmmakers to create virtual worlds for 
360-degree storytelling. 

VFX artists are helping developers create  
convincing and immersive environments, and motion 
graphics artists are adding layers of information to create rich 
visual experiences.

The VFX Festival, created by Escape Studios, part 
of Pearson College London, will run from 23-25 February 
2016 at London’s O2, bringing the best in VFX, games, 
animation and motion graphics to industry professionals 
and anyone that might be considering a career in the 
creative industries. 

Tickets for The VFX Festival 2016 are available to buy 
now from www.thevfxfestival.com.

The VFX Festival 2016Advertorial

.
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...............................................................................................................................................................
TUESDAY 23 FEBRUARY
VFX, Games & Animation Newcomers

HEADLINER: 
• The Mill – Feature on: AR and VR, Google ATAP Project
• Feature presentation – Hamilton+Kidd (VR and 360)

...............................................................................................................................................................
WEDNESDAY 24 FEBRUARY 
VFX, Games & Animation Enthusiasts

HEADLINER:  
• MPC – VFX Feature on: “The Martian”

FEATURE PRESENTATIONS: 
• Rushes (Motion Graphics Feature on “Spectre”)
• Aardman (Animation)
• Climax Studios (Game Art)

...............................................................................................................................................................
THURSDAY 25 FEBRUARY 
VFX, Games & Animation Professionals 

• Career and recruitment talks by a range of leading studios
...............................................................................................................................................................

Xxxxx xxxx xxxx xxxx xxx 
xxxx xxx xxxx xxxx xxxx xxx 
xxxx xxx xxxx xxxx xxxx xxx 
xxxx xxx xxxx xxxx xxxx xxx 

xxxx xxx xxxxxxx  xxxxxx

Develop your passion
Become industry ready with the help of 
Escape Studios’ expert teaching team  

Escape Studios has over 13 years’ experience in creating 
world-class, studio-ready talent. Escape 
offers undergraduate and postgraduate degrees and a 
range of short courses in Visual Effects (VFX), Games 
Art, Motion Graphics and Animation. Its courses are 
designed and developed with professionals from 
world-leading studios to ensure students are part of the 
industry from day one.

Escape’s number one priority is to help students 
prepare for and land great jobs, by distilling the best 
working practices from the creative industries. If you 
want to develop your passion and learn a craft, visit: 
pearsoncollegelondon.ac.uk/escape.
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Images of 
the month
These are the 3D projects 
that have been awarded 
‘Image of the week’ on 
3DArtistOnline.com in the 
last month

01

02

04 Extraction
by Anton Podvalny
3DA username 
Henrixon
Anton says: “I’ve always 

been a fan of heavy industrial 
science fiction. I wanted to make an 
atmospheric image of a laboratory 
where specialised robots extract 
some rare material mined outside 
the Earth.”
We say: We really admire Anton’s use 
of materials here, especially on the 
perspex-looking orb in the centre of 
the room and the matte metal surfaces 
on the robotic arms.

02 QBee Redesign
by Carlos Sastre 
Antoranz
3DA username 
C1-Workshop

Carlos says: “This is my Qbee 
redesign. I used 3ds Max, V-Ray, 
Photoshop and ZBrush. I’ve tried to 
give her a realistic look. It was a 
great exercise in anatomy and 
shading and I learnt a lot during the 
process, but I’m still far away from 
avoiding the uncanny valley!”
We say: Carlos’ image really feels like 
it wants to tell a story, which is a huge 
bonus in our book. The hair and also 
the skin shaders are very, very good 
here. Well done!

01 Love Bugs
by Jarrod Mark 
Hasenjager
3DA username 
Hasenjager

Jarrod says: “A moment in time 
shared by two special creatures, 
reminding us that the most 
beautiful thing we can experience is 
the mysterious.”
We say: Jarrod’s image is extremely 
charming, and on close inspection is 
extremely detailed. We’re big fans of 
the lighting and composition of this 
piece – great work.

03 Matilda
by Francis-Xavier 
Martins
3DA username 
Polyjunky

Francis-Xavier says: “I made 
Matilda for Halloween, based on a 
Max Grecke concept. I really like his 
shape language so after sculpting, I 
decided to add proper shaders and 
render it in Maya.”
We say: This is a great bit of character 
work and is clearly based on a 
wonderful concept. Slightly simpler 
cartoon styles actually aren’t easy to 
pull o�, but you wouldn’t think that 
from having seen Francis-Xavier’s 
excellent work.
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Share your work, view others’ and chat to other artists, all on our website
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Cobra by Grigorii Kliver
3DA username AirJ
Grigorii says: “Hi everyone. This model was created specifi cally 
for a car competition, which took place on one of the 3D 
resource sites. For this I used 3ds Max, Corona, HDR Light 

Studio, ZBrush and Photoshop.”
We say: Great choice of car from Grigorii here, as the Cobra’s curved body makes 
for interesting viewing. He’s done a great job of squeezing in every little detail, 
including the wheel spokes and the grill on the front.

The Naga King Mucalinda by Pichet Paithoon
3DA username Siam3d
Pichet says: “The beauty of Buddhist art is universal and can be 
perceived by everyone. In ASEAN countries we believe that 
Naga is the god of the river. The main programs I used were 

Softimage XSI and KeyShot.”
We say: We’re often seen drooling over renders of an awesome clay sculpt, and 
that’s exactly what we did when we fi rst laid our eyes on Pichet’s excellent 
reimagining of a Buddhist deity.

Ford Wheel by Mischa Annen
3DA username Mischa
Mischa says: “Originally part of a car project, I liked the outcome 
a lot so I made it into its own image by making use of MODO and 
A�  nity Designer. The tread is a displacement map, and the 

sidewall a normal map.”
We say: Those tyre treads are extremely detailed, and we love how Mischa has 
emulated a proper industrial beauty shot. Good stu� .

Last Morning of Spring by Jason Knight
3DA username jsgknight
Jason says: “This was inspired by the work of Kmye Chan and 
deeply infl uenced by other great character artists. It was an 
attempt at developing my character design skills, whilst 

concentrating on more sophisticated hair.”
We say: We really like the abstract quality that Jason has captured here with the 
girl’s exaggerated features. Great work with the hair, too!04
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YOUR FREE RESOURCES
Log in to filesilo.co.uk/3dartist and download your 3D resources NOW!

YOUR BONUS 
RESOURCES
ON FILESILO THIS ISSUE, FREE AND 
EXCLUSIVE FOR 3D ARTIST 
READERS, YOU’LL FIND OVER 4GB 
OF RESOURCES, INCLUDING…

•  Over three hours of premium 3ds Max and 
Unity video tuition from the experts at 
Pluralsight Creative (formerly Digital-Tutors)

•  Humster3D models that you can use in 
Corona Renderer

•  Four downloadable arch-vis models courtesy 
of the guys at CGAxis

• 25 awesome textures from 3DTotal
•  A huge selection of images, videos and files 

from our tutorials

CGAxis models

25 3DTotal textures

THIS MONTH’S 
COMBINED 
RESOURCE SIZE: 

filesilo.co.uk/3dartist
4GB

PLURALSIGHT GAME DESIGN VIDEOS

EVERYTHING 
YOU NEED 

TO FOLLOW 
ALONG WITH THE
MAGAZINE AND
CREATE GREAT

3D ART

Humster3D 
Corona models
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FILESILO – THE HOME OF PRO RESOURCES
A rapidly growing library 
Updated continually with cool resources
Lets you keep your downloads organised
Browse and access your content from anywhere
No more torn disc pages to ruin your magazines

No more broken discs
Print subscribers get all the content
Digital magazine owners get all the content too!
Each issue’s content is free with your magazine
Secure online access to your free resources

Discover your free online assets

The most popular downloads are shown 
in the carousel here, so check out what 
your fellow readers are enjoying

Green open padlocks show the issues 
you have accessed. Red closed padlocks 
show the ones you need to buy or unlock 

Find out more about our online stores, 
plus useful FAQs such as our cookie and 
privacy policies and contact details

If you’re looking for a particular type of 
content, like software or video tutorials, 
use the filters here to refine your search

Can’t find the resource you’re looking for 
in these filters? Click on More Types to 
specify what kind of resource you want

Top Downloads are listed here, so you 
can get an instant look at the most 
popular downloaded content

Check out the Highest Rated list to see 
the resources that other readers have 
voted for as the best

Discover our fantastic sister magazines 
and the wealth of content and 
information that they provide

The first time you use FileSilo, you’ll need 
to register. After that, you can use your 
email address and password to log in

This is the new FileSilo site that replaces 
your disc. You’ll find it by visiting the link 
on the following page
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HOW TO USE
EVERYTHING YOU NEED TO KNOW ABOUT 
ACCESSING YOUR NEW DIGITAL REPOSITORY 

Having trouble with any of the techniques in this issue’s tutorials? Don’t know how to make the 
best use of your free resources? Want to have your work critiqued by those in the know? Then 
why not visit the 3D Artist Facebook page for all your questions, concerns and qualms? There is 
a friendly community of fellow 3D artists to help you out, as well as regular posts and updates 
from the magazine team. Like us today and start chatting! 

facebook.com/3DArtistMagazine

NEED HELP WITH
THE TUTORIALS?
Having trouble with any of the techniques in this issue’s tutorials? Don’t know how to make the 
best use of your free resources? Want to have your work critiqued by those in the know? Then 

 Facebook page for all your questions, concerns and qualms? There is 
a friendly community of fellow 3D artists to help you out, as well as regular posts and updates 

NEED HELP WITH
THE TUTORIALS?

Issue 90 of  is on sale 27 January 2016 from GreatDigitalMags.com                      

To access FileSilo, please visit filesilo.co.uk/3dartist

01 Follow the on-screen 
instructions to create 

an account with our secure 
FileSilo system, and then log 
in and unlock the issue by 
answering a simple question 

about the 
magazine. You 
can access the 
content for free 
with each issue 
of 3D Artist.  

02 If you happen to be a 
print subscriber, you 

can easily unlock all the 
content by entering your 
unique Web ID. Your Web 
ID is the eight-digit 
alphanumeric code that is 
printed above your address 
details on the mailing label of 
your subscription copies. It 
can also be found on any 
renewal letters you receive. 

03 You can access 
FileSilo on any 

desktop, tablet or 
smartphone device using 
any popular browser (such 
as Safari, Firefox or Google 
Chrome). However, we 
recommend that you use a 
computer to download 
content, as you may not be 
able to download files to 
your phone or tablet.  

04 If you have any 
problems with 

accessing content on 
FileSilo, or with the 
registration process, take a 
look at the FAQs online or 
email filesilohelp@
imagine-publishing.co.uk.

HOW TO USE
 ABOUT 

ACCESSING YOUR NEW DIGITAL REPOSITORY

filesilo.co.uk/3dartist
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NVIDIA® QUADRO®

ACCELERATE
YOUR CREATIVITY.

Misco  
www.misco.co.uk
Tel: 0800 038 8880 

Scan Computers
www.scan.co.uk
Tel: 0871 472 4747

Insight  
uk.insight.com 
Tel: 0844 846 3333 

Dabs.com 
www.dabs.com
Tel: 0870 429 3825

Accelerate your creativity with NVIDIA
®

 Quadro
®

— the world’s most powerful workstation graphics. 

Whether you’re developing revolutionary products or telling spectacularly vivid visual stories, 

Quadro gives you the performance to do it brilliantly.

Learn more  www.pny.eu/quadro & pny.quadrok-selector.com

© 2014 NVIDIA Corporation. All rights reserved. NVIDIA, the NVIDIA logo, and Quadro are trademarks and/or registered trademarks of NVIDIA Corporation. All company and product names are trademarks or registered trademarks of the respective owners
with which they are associated.

NVIDIA Quadro M6000
VCQM6000-PB

NVIDIA Quadro M5000
VCQM5000-PB

NVIDIA Quadro K5000 MAC
VCQK5000MAC-PB

NVIDIA Quadro M4000
VCQM4000-PB

NVIDIA Quadro K2200
VCQK2200-PB

NVIDIA Quadro K1200DVI
VCQK1200DVI-PB

NVIDIA Quadro K620
VCQK620-PB

NVIDIA Quadro K420
VCQK420-PB

® ® ™NVIDIA Quadro  / Tesla  / GRID  / PNY SSD
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